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Introduction to 

Microsoft Excel 

 
Microsoft Excel is a member of the spreadsheet family of 

software. Spreadsheet software is used to store information 
in columns and rows which can then be organized and/or 
processed. Spreadsheets are designed to work well with 
numbers but often include text. Sometimes text in a 

spreadsheet is called a label, because it is labeling columns 
and rows of numbers. Numbers are called values 
sometimes, and can include numbers for counts or 
measurements, dates, times, and calculations from 

numbers. Spreadsheets can help organize information, like 
alphabetizing a list of names or other text or reordering 
records according to a numeric field. However, spreadsheets 

are more often used for calculating, such as totaling a 
column of numbers or generating a more sophisticated 
formula to calculate some statistical measure on a list of 
numbers. 

 
Spreadsheets and databases are in competition and have 
similar features. Yet the way they work in the background is 
different. When you work in a spreadsheet, you view the 

data you are entering as a section. In a database, you only 
see the data you are entering - you have to request a report 
or different display to see more of the information. Other 
differences are: (1) databases are more often used for 

applications with long textual entries, (2) very large 
applications (thousands of entries) are more often handled in 
databases; and (3) spreadsheets are easier to learn to use 
and get calculations from than a database program. This 

latter reason is why many researchers and students prefer 
spreadsheets for keeping track of their data over databases. 
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Building skills for success 

It is impossible to give a complete listing of applications that can be done in 
spreadsheets, but they include budgeting displays, checkbook registers, enrollment 

records, inventories, coded surveys, field and laboratory research data, and financial and 
accounting applications. 
 
The capacities of Excel are as follows. You can have 256 columns of information. You can 

have up to 65,536 rows. That comes out to over 16,777,216 cells of information and 
that’s only on the first sheet! You can have 16 sheets of information in one workbook, 
and the number of sheets can be increased, if needed. Excel refers to each file as a 
workbook, because there can be multiple sheets (pages) in one file. 

 

Starting Excel  

 
There are 2 ways to start Microsoft Excel.  
 

From the desktop: Clicking the  icon if is present. 

 

From the  button (located at leftmost bottom on your screen): 

Press the start button on the keyboard or click it with the mouse and put the mouse 

 pointer over the word All Programs and click the  icon. 

 

The Excel Window 

Many items you see on the Excel XP screen are standard in most other Microsoft 

software programs like Word, PowerPoint and previous versions of Excel. Some 
elements are specific to Excel XP. 
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Workbook 

Also called a spreadsheet, the Workbook is a unique file created by Excel XP. 

Title bar 

 

The Title bar displays both the name of the application and the name of the 
spreadsheet. 

Menu bar 

 

The Menu bar displays all the menus available for use in Excel XP. The contents of 
any menu can be displayed by clicking on the menu name with the left mouse 
button. 

Each menu groups together related commands, sometimes using submenus to further 
group commands: 

• File – Create, open, save, print, and close workbooks.  
• Edit – Perform editing functions on your workbook, including copying, cutting, 

and pasting data and objects, moving to various locations in a workbook, and 

undoing and redoing actions.  
• View – Change the workbook's display size and style.  
• Insert – Insert new worksheets, or additional space, such as new cells, columns, 

or rows; also insert charts, comments, functions, hyperlinks and other objects 

into your workbooks.  
• Format – Apply formatting to worksheets and their contents.  
• Tools – Use Excel's tools, such as the spell and grammar checker, macro 

recorder, and protection and collaboration features, and set your Microsoft Excel 
preferences.  

• Data – Sort, filter, and otherwise arrange the data on your worksheets.  
• Window – Switch between open workbook windows, or split the window of the 

current workbook.  
• Help – Access Microsoft Excel's online help.  

To access a menu command, click the main menu to open it, and then select (click) the 
command. Excel hides those commands you don't use frequently, so if you don't see a 
command, click the double arrows at the bottom of the menu to expand it. Excel then 

displays all the available commands. Once you select a command, Excel includes it with 
the others you commonly use. 

Some commands in the menus have pictures or icons associated with them. These 
pictures may also appear as shortcuts in the Toolbar. 
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Column Headings 

 

Each Excel spreadsheet contains 256 columns. Each column is named by a letter or 
combination of letters. 

Row Headings 

 

Each spreadsheet contains 65,536 rows. Each row is named by a number. 

Name Box 

 

Shows the address of the current selection or active cell. 

Formula Bar 

 

Displays information entered-or being entered as you type-in the current or active 
cell. The contents of a cell can also be edited in the Formula bar. 
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Cell 

 

A cell is an intersection of a column and row. Each cell has a unique cell address. In 
the picture above, the cell address of the selected cell is B3. The heavy border 
around the selected cell is called the cell pointer. 

Navigation Buttons and Sheet Tabs 

 

Navigation buttons allow you to move to another worksheet in an Excel workbook. 
Used to display the first, previous, next or last worksheets in the workbook. 

Sheet tabs separate a workbook into specific worksheets. A Workbook defaults to three 
worksheets. A Workbook must contain at least one worksheet. 

 

Toolbars 

The Microsoft Excel toolbars group together shortcuts to common commands; these 

shortcuts take the form of buttons. You can click a toolbar button to quickly apply 

formatting, save or print a workbook, copy or paste data, or accomplish another of a 
variety of tasks. 

 

To show or hide a toolbar, open the View menu, select Toolbars, and then select the 
toolbar you want to show or hide. You can also access the toolbar menu by right-clicking 
anywhere on a visible toolbar. 
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The most frequently used toolbars are the Standard toolbar and the Formatting 
toolbar. 

The Standard toolbar contains buttons for opening, saving, printing, and editing 
workbooks. 

 

The Formatting toolbar contains drop-down menus and buttons for applying formatting 
to worksheets. 

 

By default, these two toolbars appear next to each other, just below the menu bar. 

Other toolbars available in Excel are: 

• Chart – Create and work with charts.  
• Clipboard – View and select the contents of the clipboard.  
• Control Toolbox – Insert ActiveX controls into a form.  

• Drawing – Insert and format drawing objects.  
• External Data – Work with data imported from external sources.  
• Forms – Insert form objects.  
• Picture – Insert and format pictures.  
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• Pivot Table – Create and work with pivot tables, interactive tables for large 
amounts of data.  

• Reviewing – Insert, edit, and delete comments for or by reviewers.  
• Visual Basic – Record and run macros, and work with Microsoft Word Visual 

Basic code.  
• Web – Navigate a Web document.  
• WordArt – Insert and format WordArt.  

You can customize any of these toolbars by adding and removing buttons, or you can 
create your own toolbars to group your favorite commands: Just right-click one of the 
visible toolbars, select Customize from the menu that appears, and, in the Customize 
dialog, select the Commands tab to add or remove commands. 

Each of Excel's toolbars can be moved simply by clicking and dragging the title bar (if 
the toolbar is floating) or the move handle (if the toolbar is docked). 

The move handle is located at the left edge of the toolbar. When you move the mouse 
over it, the pointer changes to horizontal and vertical arrows, indicating you can drag 
the toolbar. 

 

1. Drag the toolbar off the row. The toolbar changes from docked to floating.  

 

2. Click the title bar and drag the toolbar back into place.  

If you drag a toolbar to a full row, the surrounding toolbars will shrink to make room for 
it. To access a button that's no longer visible, click the chevrons at the right edge of the 
toolbar. 

 

Tip: 

To quickly remove buttons you don't use, or add new buttons, select Add or Remove 
Buttons. In the menu, uncheck the buttons you don't need, or select new buttons to 
add. Select Customize to choose from all the available commands. 
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Workbooks and Worksheets 

A Workbook automatically shows in the workspace when you open Microsoft Excel 
XP. Each workbook contains three worksheets. A worksheet is a grid of cells, 

consisting of 65,536 rows by 256 columns. Spreadsheet information--text, numbers 
or mathematical formulas--is entered in the different cells. 

 

Column headings are referenced by alphabetic characters in the gray boxes that run 
across the Excel screen, beginning with the Column A and ending with Column IV. 

Rows are referenced by numbers that appear on the left and then run down the 
Excel screen. The first row is named Row 1 and the last row is named Row 65536. 

Important Terms 

• A workbook is made up of three worksheets.  
• The worksheets are labeled Sheet1, Sheet2, and Sheet3.  
• Each Excel worksheet is made up of columns and rows.  
• In order to access a worksheet, click on the tab that says Sheet#.  

The Cell 

An Excel worksheet is made up of columns and rows. Where these columns and rows 

intersect, they form little boxes called cells. The active cell, or the cell that can be 
acted upon, reveals a dark border. All other cells reveal a light gray border. Each cell 
has a name. Its name is comprised of two parts: the column letter and the row 
number. 
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In the following picture the cell C3, formed by the intersection of column C and row 
3, contains the dark border. It is the active cell. 

 

Important Terms 

• Each cell has a unique cell address composed of a cell's column and row.  

• The active cell is the cell that receives the data or command you give it.  
• A darkened border, called the cell pointer, identifies it.  

Moving Around the Worksheet 

You can move around the spreadsheet in several different ways. 

To Move the Cell Pointer: 

• To activate any cell, point to a cell with the mouse and click.  

• To move the pointer one cell to the left, right, up, or down, use the keyboard 
arrow keys.  

To Scroll Through the worksheet: 

The vertical scroll bar located along the right edge of the screen is used to move 

up or down the spreadsheet. The horizontal scroll bar located at the bottom of the 
screen is used to move left or right across the spreadsheet. 
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The PageUp and PageDown keys on the keyboard are used to move the cursor up 
or down one screen at a time. Other keys that move the active cell are Home, which 

moves to the first column on the current row, and Ctrl+Home, which moves the 
cursor to the top left corner of the spreadsheet or cell A1. 

To Move between worksheets 

As mentioned, each Workbook defaults to three worksheets. These worksheets are 

represented by tabs-named Sheet1, Sheet2 and Sheet3-that appear at the bottom of 
the Excel window. 

 
To Move from one worksheet to another worksheet: 

• Click on the sheet tab (Sheet1, Sheet2 or Sheet 3) that you want to display 
 

 
 

 
 

Challenge 

• Display the contents of every menu in the menu bar and note the icons 

associated with specific menu choices. Then, try and find the pictures or 
shortcuts in the standard toolbar.  

• Click on each of the three worksheet tabs-Sheet1, Shhet2 and Sheet3-to become 

familiar moving from sheet-to-sheet in the workbook.  
• Page Up (PgUp) and Page Down (PgDn) to get used to scrolling in a worksheet.  
• Use the horizontal and vertical scrollbars to practices scrolling up, down, left and 

right in the worksheet.  

 

 



 

  

 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

Create, Open, and 

Save Workbooks 

Understanding File Terms 

The File menu contains all the operations that we will 
discuss in this module: New, Open, Close, Save and 
Save As. 

New 

Used to create a new Workbook. 

Open 

Used to open an existing file from a floppy disk or hard 
drive of your computer. 

Close 

Used to close a spreadsheet. 

Save As 

Used when to save a new file for the first time or save an 
existing file with a different name. 
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Save 

Used to save a file that has had changes made to it. If you close the workbook without saving 
then any changes made will be lost. 

Creating a Workbook 

A blank workbook is displayed when Microsoft Excel XP is first opened. You can type 
information or design a layout directly in this blank workbook.  

To Create an Excel XP Workbook: 

• Choose File New from the menu bar. 

 

 

• The New Workbook task pane opens on the right side of the screen. 
 

 

• Choose Blank Workbook under the New category heading.  
• A blank workbook opens in the Excel window. The New Workbook task pane is closed.  
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Saving a Workbook 

Every workbook created in Excel must be saved and assigned a name to distinguish it from 
other workbooks. The first time you save a workbook, Excel will prompt you to assign a name 

through the Save As operation. Once assigned a name, any additional changes made to the 
text, numbers or formulas need to be saved using the Save operation. 

To Save a new Workbook: 

• Choose File Save As from the menu bar. 

 

 

• The Save As Dialog Box appears.  

• Click on the Save In: dropdown menu and locate where the file will be saved. Choose 3 
1/2 Floppy (A:) to save the file to a floppy disk or Local Disk (C:) to save the file to 
your computer.  

• Type a name for your file in the File Name: box.  
• Click the Save button. 
 

 

To Save Changes Made to an Existing Workbook: 

• Choose File Save from the menu bar, or 

 

Click the Save button on the Standard toolbar.  

If you're saving the file for the first time and you do not choose a file name, Microsoft Excel 
will assign a file name for you. 
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It is a good idea to Save frequently when working in a spreadsheet. Losing information is 
never fun! You can quickly save your spreadsheet by using the quick-key combination Ctrl + S. 

Opening a Workbook 

You can open any workbook that has previously been saved and given a name. 

To Open an Existing Excel XP Workbook: 

• Choose File Open from the menu bar. 

 

 

• The Open dialog box opens. 
 

 

• In the Look in list, click the drive, folder, or Internet location that contains the file you 
want to open.  

• In the folder list, open the folder that contains the file. Once the file is displayed, click on 
the file you want to open.  

• Click the Open button.  
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Closing a Workbook 

 
To close an existing Excel XP Workbook: 

• Choose File Close from the menu bar. The workbook in the Excel window is closed. 

 

 

Excel XP will prompt you to save information if any has been typed between the last save 
and the time you close the file. 

Challenge 

• Create a new blank file and save as to c:\my documents as "test.xls"  

• Close the file "test.xls"  

• Open the file "test.xls"  
• Save the file "test.xls"  

 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 



 

  

Enter, Edit and 

Delete Data 

Entering Text in a Cell 

You can enter three types of data in a cell: text, 
numbers, and formulas. Text is any entry that is not a 

number or formula. Numbers are values used when 
making calculations. Formulas are mathematical 
calculations. 

To Enter Data into a Cell: 

• Click the cell where you want to type 
information.  

• Type the data. An insertion point appears in the 
cell as the data is typed. 
 

 

• The data can be typed in either the cell or the 
Formula bar. 
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• Data being typed appears in the both active cell and in the formula bar. 

 

 

• Notice the Cancel and Enter buttons in the formula bar. 
 

 

• Click the Enter button to end the entry and turn off the formula bar buttons.  

Excel's AutoComplete feature keeps track of previously-entered text. If the first few 
characters you type in a cell match an existing entry in that column, Microsoft Excel fills in the 
remaining characters for you. 

Entering More Than One Line of Text in a Cell 
 
To enter more than one line of text in one cell: 

• Type the first line in the cell 
 

 
 
• Hold the Alt key and press Enter button 
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Notice the column header is covered because the formula bar is expanded to two lines. 
 

• Type the next line in the cell  
 

 
In this example, the next line typed is “Voucher.” 
 

• Press the Enter button to finish. 
 

 
 

To enter more than two lines of text, just repeat the second and third steps for each line.  

Pointer Shapes to Remember 

As with other Microsoft programs, the shape of the pointer changes as you are working with 

the program. Each pointer shape is communicating something about how Excel is working. The 
shape of the pointer when you click and drag a cell will greatly influence the results of the click 
and drag. The following table document includes a table that describes each of the pointer 

shapes that you may encounter in your Excel work.  
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Shape Meaning Action 

 
The default pointer shape. Move cell pointer or 

select a range of cells 

 
When the pointer is on a border (column, row, 
or window), the pointer changes to a two-
headed black pointer. When adjusting row 

height, the arrow goes up and down. When 
adjusting column width, the arrows point right 
to left. 

Adjust the column 
width, row height, or 
window size 

 When you are editing the contents of a cell, 

the pointer will change to an I-beam.  

Move the insertion 

point within the cell 

 
 

The pointer turns to a four-headed arrow when 
you have a graphic that may be moved  

With the pointer over 
the graphic, click and 
drag to the new 

location 

 
 

Appears when you are pointing to the border of 
a cell.  

Click and drag cell to a 
new location 

 

Appears when you are at the "fill corner" of a 
cell or range of cells. 
 

Click and drag the fill 
corner to AutoFill other 
cells with similar 

information 

 
Editing Information in a Cell 

Information in a spreadsheet is likely to change over time. Information can be changed in 
either of two ways. 

Quick and Easy Method: 

• Click the cell that contains the information to be changed.  
• Type the new entry. The old entry is replaced by the new entry.  

If the original entry is long and requires only a minor adjustment (in spelling, for example), 
then you can directly edit the information in the cell. 

To Edit Information in a Cell: 

Method 1: Direct Cell Editing 

• Double-click on the cell that contains the information to be changed.  
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• The cell is opened for direct editing. 
 

 

• Make the necessary corrections.  

• Press Enter or click the Enter button on the Formula bar to complete the entry.  

Method 2: Formula Bar Editing 

• Click the cell that contains the information to be changed.  

• Edit the entry in the formula bar. 
 

 

Deleting Information in a Cell 
 
To Delete Data that Already Appears in a Cell: 

• Click the cell that contains the information to be deleted.  

• Click on the information displayed in the formula bar.  

• Click the Cancel button to delete an entry and turn off the formula buttons.  

OR 

• Click the cell that contains the information to be deleted.  
• Press the Delete key, or  
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• Right-click and choose Clear Contents from the shortcut menu. 
 

 

To Delete Data Being Typed But Not Yet Added to the Cell: 

• Cancel an entry by pressing the Escape key.  

Performing Undo and Redo 

Sometimes, you might do something to a spreadsheet that you didn't mean to do, like type the 

wrong number in a cell. Excel XP allows you to undo an operation. Use the Undo button on 
the Standard toolbar to recover an error. The last single action is recoverable. 

To Undo Recent Actions (typing, formatting, etc), One at a Time: 

• Click the Undo button.  

To Undo Several Recent Actions at Once: 

• Click the arrow next to the Undo button.  
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• Select the desired Undo operation(s) from the list. 
 

 

• Microsoft Excel reverses the selected action and all actions that appear in the list above it.  

An Undo operation can be cancelled by applying a Redo. This is useful when an Undo 
operation was mistakenly applied. Remember, a Redo is possible only if you have not changed 
an Excel spreadsheet since the last Undo operation was completed: 

To Redo an Undo Operation: 

• Press the Redo button.  

To Redo several recent Undo actions at once: 

• Click the arrow next to Redo button.  

• Select the desired Redo operation from the list.  
• Microsoft Excel reverses the Undo operation.  

Selecting Multiple Cells 

The currently-selected cell in Excel XP is called the active cell. You can also select a group of 

adjacent cells, or a cell range. Many operations can be done against a cell range: move it, 
copy, it, delete it or format it. A cell range can be defined in different ways: select a specific 
range of cells, select multiple columns or rows, or select the entire worksheet. 

To Select a Range of Cells: 

• Move to the first cell in the range.  

• The mouse pointer becomes a large cross.  

• Click-and-hold the left mouse button and drag left or right, up or down to the last cell you 
want to select.  

• Release the mouse button.  
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• The cells you selected are shaded. 
 

 

To Select All Cells in a Column or Row: 

• Click the gray Column heading to select the entire column. (Click and drag the cursor 

across other column headings to select those columns). 
 

 

• Click the gray Row heading to select the entire row. (Click and drag the cursor down 
through the row headings select those rows). 
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To Select the Entire Worksheet: 

• Click the gray rectangle in the upper left corner to select entire worksheet. 

 

 

If the cells and columns you want to select are not directly next to one another, select one 
of the ranges you want to select, and hold down the Control key while selecting other ranges. 

 
 

 
Ranges in Excel are used in a variety of ways. You can select a range to apply the same 
formatting to all the cells (such as font, size, color, borders, and shading), or you can enter the 
same data into each of the cells in the range using the Ctrl + Enter shortcut: 

1. Select the range.  

 

2. Type the data.  
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3. Press Ctrl + Enter.  

 

Ranges are also used in performing calculations. When you enter a formula in the formula bar, 

you designate a range by typing the first cell in the range, followed by a colon (:), followed by 
the last cell in the range. For example: 

A1:F3 

The range above includes cells A1 through A3, B1 through B3, C1 through C3, and so on 
through cell F3. 

 

Challenge 

• Type the following data in the spreadsheet:  

In cell B1, type Name  

In cell C1, type Address  
In cell D1, type Phone  
In cell B2, type Jay  
In cell C2, type 123 Street  

In cell D2, type 555-5555  
In cell B3, type Lisa  
In cell C3, type 456 Street  
In cell D3, type 555-1213 

• Edit the label entered in cell B1 using the Direct Cell Editing method. Change Name to 
First Name.  

• Delete the phone number that appears in cell D3.  
• Undo the last operation.  

• Edit the phone number entered in cell D3 using the Formula Bar Editing method. Change 
the phone number to 555-1214.  

• Select all the contents of any column or row.  



 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Moving, Copying, 

and Deleting Cell 

Contents 

Cut, Copy, Paste Defined 

Cut, Copy and Paste are very useful operations in Excel 
XP. You can quickly copy and/or cut information in cells 

(text, numbers or formulas) and paste them into other 
cells. These operations save you a lot of time from 
having to type and retype the same information. 

The Cut, Copy and Paste buttons are located on the 
Standard toolbar. 

 

The Cut, Copy and Paste operations also appear as 
choices in the Edit menu: 

 

 
 
 
 
 
 
 
 
 
 
L E S S O N  
 
 
 
 
 
 
 
 

+      +      +      + 
 

In This Lesson: 
 

Cut, Copy, Paste Defined 
 
Copy and Paste Cell 
Contents 
 
Cut and Paste Cell Contents 
 
Moving Information Using 
Drag-and-Drop 
 
AutoFill 
 
 
+      +      +      + 

 

4444



Lesson 4 – Moving, Copying, and Deleting Cell Contents   31313131 

 

  
Building skills for success 

The Cut, Copy and Paste operations can also be performed through shortcut keys: 

Cut Ctrl+X 
Copy Ctrl+C 

Paste Ctrl+V 
 
 

Copy and Paste Cell Contents 

The Copy feature allows you to copy selected information from the spreadsheet and 

temporarily place it on the Clipboard, which is a temporary storage file in your computer's 
memory. The Paste feature allows you to select any of the collected items on the Clipboard 
and paste it in a cell of the same or different spreadsheet. 

To Copy and Paste: 

• Select a cell or cells to be duplicated.  

• Click on the Copy button on the standard toolbar.  
• The border of the copied cell(s) takes on the appearance of marching ants. 

 

 

• Click on the cell where you want to place the duplicated information. The cell will be 
highlighted. If you are copying contents into more than one cell, click the first cell where 
you want to place the duplicated information. 
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• Press the Enter key. Your information is copied to the new location.  

Be careful if you paste copied cell information into cells that already contain data. If you do, 
the existing data is overwritten. 

 

Cut and Paste Cell Contents 

The Cut feature allows you to remove information from cells in the spreadsheet. Information 

that is cut can be pasted in another cell, as long as the pasting occurs before you perform 
another operation. If you don't paste the cut information immediately, it is removed from the 
Office clipboard. 

To Cut and Paste: 

• Select a cell or cells to be cut.  

• Click on the Cut button on the Standard toolbar.  

• The information in the cell is deleted.  
• The border of the cut cell(s) take on the appearance of marching ants.  
• Click on the cell where you want to place the duplicated information. The cell will be 

highlighted. If you are copying contents into more than one cell, click the first cell where 

you want to place the duplicated information. 
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• Press the Enter key. Your information is pasted to the new location.  

Moving Information Using Drag-and-Drop 

Another way to move information from one cell to another is to use the drag-and-drop method. 

You use the cursor to point to the information to be moved and then drag the cell to its new 
location. 

To Use Drag and Drop: 

• Highlight and select the cell(s) you want to move to a new location.  

• Position the mouse pointer near one of the outside edges of the selected cell(s). The 
mouse pointer changes from a large, white cross and becomes a slender, black cross with 
arrows at all ends. 

 

 

• Keep the mouse pointer on the outer edge of the selected cell, click and hold the left 

mouse button and drag the cell(s) to a new location. 
 

 

• Release the mouse button to move the information to its new location.  

AutoFill 

MS Excel contains a feature called AutoFill, which copies a logical series of values, labels or 
formulas. The AutoFill handle can be located at the bottom right corner of the Active Cell(s).  

Place the pointer over the small square in the bottom right corner of the Active Cell(s). The 
pointer will change to a cross hair. Click and Drag in any direction. The data to be entered 
automatically will pop-up. Then release the mouse.  

EXAMPLES:  
   

If you Enter: The result will be: 

Monday Tuesday, Wednesday, Thursday, etc. 

January February, March, April, etc. 

1 Qtr 2 Qtr, 3 Qtr, 4 Qtr 

1/2/00 1/3/00, 1/4/00, 1/5/00, etc. 
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To get numbers in a specific sequential order (1,2,3 or 10,20,30), you MUST set up a two cell 
pattern for AutoFill to follow.  

Type the first two numbers in the sequence in two separate cell. Select both cells and THEN 
AutoFill.  

 

Challenge 

• Type the words cut in cell A1, copy in cell B1 and paste in cell C1.  

• Highlight a cell range to include cell A1 and cell B1.  
• Move the cell range to cell D1 and cell E1.  
• Cut the information in cell E1 (it should be the word, copy).  
• Paste the cut information in cell A1.  

• Copy the contents of cell A1 (it should be the word, copy).  
• Paste the copied information in cell F1.  



 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Inserting, 

Deleting, and 

Hiding Rows and 

Columns 

 

Inserting a Row 

You can insert a row in a spreadsheet anywhere you 

need it. Excel moves the existing rows down to make 
room for the new one. 

To Insert a Row: 

• Click anywhere in the row below where you 

want to insert the new row.  
• Choose Insert Rows from the menu bar. 

 

• A new row is inserted above the cell(s) you 
originally selected.  
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OR 

• Click anywhere in the row below where you want to insert the new row.  
• Right-click and choose Insert from the shortcut menu. 

 

 

• The Insert dialog box opens. 
 

 

• Choose the Entire Row radio button.  

• Click the OK button.  
• A new row is inserted above the cell(s) you originally selected. 
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Select multiple rows before choosing Insert to add rows quickly. Excel inserts the same 
number of new rows that you originally selected. 

Inserting a Column 

In Excel, you can insert a column anywhere you need it. Excel moves the existing columns to 
make room for the new one. 

To Insert a Column: 

• Click anywhere in the column where you want to insert a new column.  

• Choose Insert Columns from the menu bar. 
 

 

• A new column is inserted to the left of the existing column.  

OR  

• Click anywhere in the column where you want to insert a new column.  
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• Right-click and choose Insert from the shortcut menu. 
 

 

• The Insert dialog box opens. 

 

 

• Click the Entire Column radio button in the Insert dialog box.  
• Click the OK button.  
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• A new column is inserted to the left of the existing column. 
 

 

You can also select multiple columns before choosing Insert to add columns quickly. Excel 
inserts the same number of new columns that you originally selected. 

Deleting Columns and Rows 

Columns and rows are deleted in much the same manner as inserting columns and rows. 

To Delete a Row and All Information in It: 

• Select a cell in the row to be deleted.  

• Choose Edit Delete from the menu bar.  

• Click the Entire Row radio button in the Delete dialog box. 
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• Click the OK button.  

To Delete a Column and All Information in it: 

• Select a cell in the column to be deleted.  

• Choose Edit Delete from the menu bar.  
• Click the Entire Column radio button in the Delete dialog box. 

 

 

• Click the OK button.  

Hiding Columns and Rows 

At times, there may be information in your worksheet which you no longer need to see. At 

other times, you might be printing your worksheet and want to print only columns A-F and 
columns H-J, skipping column G. Rather than rearrange your worksheet for either of these 
examples, you can simply hide the information. You can also hide information in specific cells. 
The following topics are included in this document:  

Hiding Columns 

If there is information on your worksheet you do not need to see or if you want to print only 
certain columns, you can hide those columns you do not want to see or print. 

1. Select a cell within the column(s) to be hidden  
2. From the Format menu, select Column » Hide 

The column is hidden.  

Hiding Columns: Quick Menu Option 

1. Right click the column ID (e.g., B) » select Hide 
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Redisplaying Columns 

1. Select at least one cell from both of the columns around the hidden column(s) to be 

redisplayed, e.g., if column B is hidden, select a cell from both columns A and C  

HINT: If you cannot select the appropriate cells, you can use the Go To command.  
2. From the Format menu, select Column » Unhide 

The column reappears.  

Redisplaying Columns: Quick Menu Option 

1. Hold your cursor over ID for a column on either side of the hidden column 

The cursor will change to an open, double sided arrow as shown here. 

 
2. Windows: Right click » select Unhide   

Redisplaying Column A: Quick Menu Option 

This option works well for redisplaying column A, since there are not columns on both sides of 
column A. 

1. Hold you cursor over ID for column B toward the left side 

The cursor will change to an open, double sided arrow as shown here.  

 
2. Right click » select Unhide  

  

 

Hiding Rows 

If there is information on your worksheet you do not need to see or if you want to print only 
certain rows, you can hide those rows you do not want to see or print. 

1. Select a cell within the row(s) to be hidden  
2. From the Format menu, select Row » Hide 

The row is hidden.  

Hiding Rows: Quick Menu Option 

1. Right click the row ID (e.g., 5) » select Hide 

Redisplaying Rows 

1. Select at least one cell from both of the rows around the hidden row(s) to be redisplayed, 

e.g., if row 5 is hidden, select a cell from rows 4 and 6. 
HINT: If you cannot select the appropriate cells, you can use the Go To command.  

2. From the Format menu, select Row » Unhide 
The row reappears.  
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Redisplaying Rows: Quick Menu Option 

1. Hold your cursor over the ID for a row on either side of the hidden row 
The cursor will change to an open, double sided arrow as shown here. 

 
2. Right click » select Unhide   

Redisplaying Row 1: Quick Menu Option 

This option works well for redisplaying row 1, since there are not rows on both sides of row 1. 

1. Hold your cursor over the ID for row 2 toward the top 
The cursor will change to an open, double sided arrow as shown here. 

 
2. Right click » select Unhide   

 

Challenge 

• In column A, type the following names in cells A1, A2, A3 and A4, respectively:  

Mary, in cell A1 

Bob, in cell A2 
Susan, in cell A3 
John, in cell A4 

• In column B, type the following numbers next to each name entered in column A:  

44, in cell B1, to the right of Mary's name 
28, in cell B2, to the right of Bob's name 

36, in cell B3, to the right of Susan's name 
89, in cell B4, to the right of John's name 

• Insert a column between columns A and B. Type the following numbers in the new 
column B.  

76, in cell B1, to the right of Mary's name 
57, in cell B2, to the right of Bob's name 

29, in cell B3, to the right of Susan's name 
61, in cell B4, to the right of John's name 

• Insert a row between rows 2 and 3. Type the following numbers in the new row 3.  

Rick, in cell A3 
45, in cell B3 
58, in cell C3 
61, in cell B4 

 

 



 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Changing Column 

Width and Row 

Height 

Adjusting Column Widths 

By default, Excel's columns are 8.43 characters wide, but 
each individual column can be enlarged to 240 characters 
wide. 

If the data being entered in a cell is wider or narrower 
than the default column width, you can adjust the 
column width so it is wide enough to contain the data. 

 

You can adjust column width manually or use 
AutoFit. 

To Manually Adjust a Column Width: 

• Place your mouse pointer to the right side of 
the gray column header.  
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• The mouse pointer changes to the adjustment tool (double-headed arrow). 
 

 

• Drag the Adjustment tool left or right to the desired width and release the mouse button. 
 

 

To AutoFit the Column Width: 

• Place your mouse pointer to the right side of the column header.  

• The mouse pointer changes to the adjustment tool (double-headed arrow).  
• Double-click the column header border.  
• Excel "AutoFits" the column, making the entire column slightly larger than the largest entry 

contained in it.  

To access AutoFit from the menu bar, choose Format Column AutoFit Selection. 

Adjusting Row Height 

Changing the row height is very much like adjusting a column width. There will be times 

when you want to enlarge a row to visually provide some space between it and another row 
above or below it. 

To Adjust Row Height of a Single Row: 

• Place your mouse pointer to the lower edge of the row heading you want to adjust.  
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• The mouse pointer changes to the adjustment tool (double-headed arrow). 
 

 

• Drag the Adjustment tool up or down to the desired height and release the mouse button. 

 

 

To AutoFit the Row Height: 

• Place your mouse pointer to the lower edge of the row heading you want to adjust.  

• The mouse pointer changes to the adjustment tool (double-headed arrow).  
• Double-click to adjust the row height to "AutoFit" the font size.  

Excel XP "AutoFits" the row, making the entire row slightly larger than the largest entry contained in the row.  
 

Challenge 

• Type the sentence, "Mary had a little lamb," in cell B2.  

• Define the row height of row 2 as 25.  
• AutoFit the column width of column B.  

 

 

 

 



 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Inserting, 

Deleting, Merging, 

and Hiding Cells 

Inserting a Cell 

When working in an Excel XP worksheet, you may need 
to insert or delete cells without inserting or deleting 
entire rows or columns. 

To Insert Cells: 

• Select the location where the new cell(s) should 

be inserted. It can be a single cell or a range of 
cells. 

• Right-click and choose Insert. 

 
Note: You could also choose Insert Cell on 
the menu bar. 
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• The Insert dialog box opens. Select either:  
• Shift cells right to shift cells in the same row to the right.  

• Shift cells down to shift selected cells and all cells in the column below it downward. 
 

 

• Choose an option and click the OK button.  

• Your result displays in the spreadsheet. 
 

 

Remember, you can also use the Insert dialog box to insert or delete columns and rows. 

Deleting a Cell 
 
To Physically Delete the Cell from the Spreadsheet: 

• Right-click and choose Delete. 

 

 

• The Delete dialog box opens. Select either:  
• Shift cells left to shift cells in the same row to the left.  
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• Shift cells up to shift selected cells and all cells in the column above it upward. 
 

 

• Choose an option and click the OK button.  
• Your result displays in your spreadsheet.  

Merging Cells 

In Excel XP, you have another alignment option available to you: merge and center. This is 

performed when you want to select one or more cells and merge them into a larger cell. The 
contents will be centered across the new merged cell. 

The picture below shows why we might want to merge two cells. The spreadsheet presents 
Last Month and This Month Sales and Expenses for Sally. Notice that Sally's name appears 

above the Last Month column. To evenly center Sally's name across the two cells we would 
perform a merge and center. 
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To Merge Two Cells Into One: 

• Select the cells that you want to merge. It can be cells in a column, row or both columns 

and rows.  

• Click the Merge and Center button on the standard toolbar. 
 

 

 

• The two cells are now merged into one. 
 

 

Hiding Cell Contents 

You have the ability to hide the contents of individual cells if you do not need to view their 
contents or you simply do not want to print certain cells. 

1. Select the cell(s) to be hidden  
2. From the Format menu, select Cells ... 

The Format Cells dialog box appears.  

3. From the Format Cells dialog box, select the Number tab  
4. Under Category, select Custom  
5. In the Type text box, type three semicolons ( ;;; )  
6. Click OK 

The cell(s) is now hidden. 

To redisplay cell information: 

1. Select the cell(s) to be redisplayed  
2. From the Format menu, select Cells ... 

The Format Cells dialog box appears.  
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3. From the Format Cells dialog box, select the Number tab  
4. Under Category, select the appropriate date, time, or number format  

5. Click OK 
The cell(s) reappears.  

 

Challenge 

• Type the name "Oscar" in cell B2.  

• Type the name "Ben" in cell C2.  
• Type the name "Ruth" in cell D2.  
• Insert a cell between cell C2 and cell D2, and then "shift the cells right."  
• Type the name "Mary" in new cell D2.  

• Type the label "Sales People" in cell B1.  
• Merge and Center cells B1, C1, D1 and E1.  



 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Creating Simple 

Formulas 

About Formulas 

In school, you learned formulas used to calculate math 
problems. Microsoft Excel uses these same formulas to 
perform calculations in a spreadsheet. 

A formula can be a combination of values (numbers or 
cell references) and math operators (+, -, /, *, =) into 
an algebraic expression. Excel requires every formula to 
begin with an equal sign (=). 

The following table illustrates the mathematical operators 
learned in school and those represented in Excel XP. 

 School Excel XP 
Addition + + 
Subtraction - - 

Multiplication X * 
Division / / 
Equals = = 

 

The result of a formula-the answer to 2+3, for example-

displays in the cell on the Excel worksheet. The formula 
is visible only in the formula bar. A formula's result will 
change as different numbers are entered into the cells 
included in the formula's definition. 
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Creating a Simple Addition Formula 

A simple formula in Excel contains one mathematical operation only: one number plus a 
second number equals a third number. Writing a simple formula is really no more difficult than 

that: 1+1. The only difference in Excel is that all formulas must begin with the equal sign 
(=). It is not enough to type 1+1 in Excel because what will appear in the cell is "1+1." You 
must begin the equation with an equal sign, or =1+1. This holds true for any formula, simple 
or complicated, that adds, subtracts, multiplies or divides. 

Let's add two numbers to create a third, 128+345=473. In Excel XP, this would be expressed 
by the formula, =128+345, as shown below. 

 

To Create a Simple Formula that Adds Two Numbers: 

• Click the cell where the formula will be defined.  
• Type the equal sign (=) to let Excel know a formula is being defined.  

• Type the first number to be added (128, for example)  
• Type the addition sign (+) to let Excel know that an add operation is to be performed.  
• Type the second number to be added (345, for example  
• Press Enter or click the Enter button on the Formula bar to complete the formula.  

But what if a column contains many numbers, each of which regularly changes? You don't want 
to write a new formula each time a number is changed. Luckily, Excel XP lets you include cell 
references in formulas. 

A formula can add the value of two cells-B2 and B3, for example. Type any two values in these 
two cells and the formula will adjust the answer accordingly. 

Using this method to calculate two numbers-128 and 345, for example-requires that you type 

128 in cell B2, for example, and 345 in cell B3. The Excel formula, =B2+B3, would then be 
defined in cell B4. 
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To Create a Simple Formula that Adds the Contents of Two Cells: 

• Type the numbers you want to calculate in separate cells (for example, type 128 in cell B2 

and 345 in cell B3).  
• Click the cell where the answer will appear (B4, for example).  
• Type the equal sign (=) to let Excel know a formula is being defined.  

• Type the cell number that contains the first number to be added (B2, for example).  
• Type the addition sign (+) to let Excel know that an add operation is to be performed.  
• Type the cell number that contains the first number to be added (B3, for example).  
• Press Enter or click the Enter button on the Formula bar to complete the formula.  

Creating a Simple Subtraction Formula Using the Point-and-Click Method 

Formulas can be created by using either numbers or cell references in the definition. You can 

also use the mouse to select the cells to be used in the formula instead of typing the cell 
number or cell reference. Using this method, we are going to write a simple formula that 
subtracts one cell from another: =B3-B2. 

 

To Create a Simple Formula using the Point and Click Method: 

• Type the numbers you want to calculate in separate cells (for example, type 128 in cell B2 

and 345 in cell B3).  
• Click the cell where the answer will appear (B4, for example).  

• Type the equal sign (=) to let Excel know a formula is being defined.  
• Click on the first cell to be included in the formula (B3, for example).  
• Type the subtraction sign (-) to let Excel know that a subtraction operation is to be 

performed.  
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• Click on the next cell in the formula (B2, for example).  
• If you include multiple cells in the formula, repeat steps 4 and 5 until the entire formula is 

entered.  
• Press Enter or click the Enter button on the Formula bar to complete the formula.  

Creating Simple Multiplication Formulas 

• Creating multiplication formulas is very similar to addition and subtraction formulas. To 

multiply two cells the formula, B2 and B3, you would need to insert a multiplication operator 

* between them, =B2*B3. Press Enter or click the Enter button on the Formula bar to 
complete the formula.  

 

Creating Simple Division Formulas 

Creating division formulas is very similar to the addition, subtraction and multiplication 

formulas. To divide the contents of cell B2 by cell B3, you would need to insert a division 
operator / between them, =B2/B3. Press Enter or click the Enter button on the Formula bar 
to complete the formula. 

 

 

Challenge 

• In cell A1, type 1234  

• In cell A2, type 15865  

• Click the cell where you want the result to appear.  
• Type a formula in cell A3 that adds cell A1 and cell A2  
• Type a formula in cell A4 that subtracts cell A1 from cell A2  
• Type a formula in cell A5 that multiplies cell A1 by cell A2  
• Type a formula in cell A6 that divides cell A2 by cell A1  

 

 

 



 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Creating Complex 

Formulas  

Complex Formulas Defined 

Simple formulas have one mathematical operation. 
Complex formulas involve more than one mathematical 
operation. 

The order of mathematical operations is very important. 
If you enter a formula that contains several operations--
like adding, subtracting and dividing--Excel XP knows to 

work those operations in a specific order. The order of 
operations is: 

1. Operations enclosed in parenthesis  
2. Exponential calculations (to the power of)  
3. Multiplication and division, whichever comes first  
4. Addition and subtraction, whichever comes first  

Using this order, let us see how the formula 120/(8-
5)*4-2 is calculated in the following picture: 
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Let's take a look at another example: 

2*(6-4) =? 

Is the answer 8 or 4? Well, if you ignored the parentheses and calculated in the order in which 
the numbers appear, 2*6-4, you'd get the wrong answer, 8. You must follow the order of 
operations to get the correct answer. 

To Calculate the Correct Answer: 

• Calculate the operation in parenthesis (6-4), where the answer is 2.  

• Multiply the answer obtained in step #1, which is 2, to the numeric 2* that opened the 
equation. In other words, multiply 2*2.  

• The answer is 4.  

When using formulas with cell references, the results change each time the numbers are 
edited. 

Remember: In Excel, never do math "in your head" and type the answer in a cell where you 
would expect to have a formula calculate the answer. 

Before moving on, let's explore some more formulas to make sure you understand the order of 
operations by which Excel calculates the answer. 

5*3/2 Multiply 5*3 before 
performing the 
division operation 
because the 

multiplication sign 
comes before the 
division sign. The 

answer is 7.5. 

5/3*2 Divide 5/3 before 
performing the 
multiplication 

operation because 
the division sign 
comes before the 
multiplication sign. 

The answer is 
3.333333. 

5/(3*2) Perform the 

operation in 
parentheses (3*2) 
first and divide this 
result by 5. The 

answer is 0.833333. 

5+3-2 Add 5+3 before 
performing the 

subtraction operation 
because the addition 
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sign comes before 
the subtraction sign. 

The answer is 6. 

5-2+3 Subtract 5-2 before 
performing the 
addition operation 

because the 
subtraction sign 
comes before the 

addition sign. The 
answer is 6. 

5-2*3 Multiply 2*3 before 
performing the 

subtraction operation 
because the 
multiplication sign is 
of a higher order 

than the subtraction 
sign. The answer is -
1. 

(5-2)*3 Perform the 
operation in 
parenthesis (5-2) 
first and then 

multiply by 3. The 
answer is 9. 

 

Creating Complex Formulas 

Excel XP automatically follows a standard order of operations in a complex formula. If you 
want a certain portion of the formula to be calculated first, put it in parentheses. 

If we wanted to add the contents of cell B2 and cell B3, for example, and then take that 
answer and multiply it by the data in cell A4, then we would need to define the following 
formula: =(B2+B3)*A4. 

 

• Enter the numbers you want to calculate.  
• Click the cell where you want the formula result to appear.  
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• Type the equal sign (=) to let Excel know a formula is being defined.  
• Type an open parenthesis, or (  

• Click on the first cell to be included in the formula (cell B2, for example).  
• Type the addition sign (+) to let Excel know that an add operation is to be performed.  
• Click on the second cell in the formula. The reference B3 displays where you want your 

result.  

• End the B2+B3 operation by adding the close parenthesis, or )  
• Type the next mathematical operator, or the multiplication symbol (*) to let Excel know 

that an multiply operation is to be performed.  

• Click on the third cell to be included in the formula, cell A4.  

• Very Important: Press Enter or click the Enter button on the Formula bar. This step 
ends the formula.  

Try changing one of the values in the formula and watch the answer to the formula change. 

Filling Formulas to Other Cells (AutoFilling Formulas) 

Sometimes, you will write a formula that gets used a lot in different places of a worksheet. For 

example, a spreadsheet may contain several columns of numbers. Each column will contain a 
formula that adds all the numbers in it. You could write the formula several times, once in each 

column. Or you could copy-and-paste it into each column. The fill formula method allows you 
to copy a formula and fill it into many different consecutive cells at the same time. 

The mouse pointer changes to a black crosshair when passed over the fill handle, or the square 
box in the lower right corner of the cell. 

 

To Use the Fill Handle to Copy a Formula to a Surrounding Cell: 

• Click on the cell that contains the formula to be copied.  

• Position the mouse pointer over the fill handle.  
• Click and hold the left mouse button, and then drag the contents to the cell that's to 

receive the fill formula.  
• Release the mouse button.  
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• Select the Copy Cells option in the fill formula drop-down menu. 
 

 

The cell references in a formula are automatically updated when the formula is copied to other 
cells in the spreadsheet. 

You can also use copy and paste to copy a formula to other cells.  

Copy and Paste Formulas 

The process to copy and paste a formula is identical to that process used to copy and paste 
text. 

To Copy and Paste a Formula: 

• Select the cell that contains the formula to be copied.  

• Click the Copy button. Marching "ants" appear around the copied cell(s). 

 

 

• Select the cell where the copied formula is to be pasted.  
• Press the Enter key. The formula is copied to the new location.  
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Revising Formulas 

You can revise any formula that was previously written in a worksheet. 

To Revise a Formula using the Keyboard: 

• Double-click the cell that contains the formula you want to revise.  

• The cursor can now move left and right between the values in the formula in cell B5. 

 

 

• Make the necessary changes to the formula.  
• Press the Enter key or click the Enter button to accept the new formula.  

Relative and Absolute Cell References 

Excel uses two types of cell references to create formulas.  Each has its own purpose.  Read on 
to determine which type of cell reference to use for your formula.  

Relative Cell References  

This is the most widely used type of cell reference in formulas.  Relative cell references are 
basic cell references that adjust and change when copied or when using AutoFill. 

Example:  

=SUM(B5:B8), as shown below, changes to =SUM(C5:C8) when copied across to the next cell. 
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Absolute Cell References  

Situations arise in which the cell reference must remain the same when copied or when using 
AutoFill.  Dollar signs are used to hold a column and/or row reference constant. 

Example:  

In the example below, when calculating commissions for sales staff, you would not want cell 
B10 to change when copying the formula down.  You want both the column and the row to 
remain the same to refer to that exact cell.  By using $B$10 in the formula, neither changes 
when copied. 

 

 

A more complicated example:  

Let's pretend that you need to calculate the prices of items in stock with two different price 
discounts. Take a look at the worksheet below. 
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Examine the formula in cell E4. By making the first cell reference $C4, you keep the column 

from changing when copied across, but allow the row to change when copying down to 
accommodate the prices of the different items going down.  By making the last cell reference 
A$12, you keep the row number from changing when copied down, but allow the column to 

change and reflect discount B when copied across.  Confused?  Check out the graphics below 
and the cell results. 

Copied Across 

 

Copied Down 

 

Now, you might be thinking, why not just use 10% and 15% in the actual formulas?  Wouldn't 
that be easier? Yes, if you are sure the discount percentages will never change - which is 

highly unlikely.  It's more likely that eventually those percentages will need to be adjusted.  By 
referencing the cells containing 10% and 15% and not the actual numbers, when the 
percentage changes all you need to do is change the percentage one time in cell A12 and/or 
B12 instead of rebuilding all of your formulas. Excel would automatically update the discount 
prices to reflect your discount percentage change. 
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Summary of absolute cell reference uses:  

   

$A1 

Allows the 
row 
reference 
to change, 
but not the 
column 
reference. 

A$1 

Allows the 
column 
reference 
to change, 
but not the 
row 
reference. 

$A$1 

Allows 
neither the 
column nor 
the row 
reference 
to change. 

There is a shortcut for placing absolute cell references in your formulas!  

When you are typing your formula, after you type a cell reference - press the F4 key.  Excel 

automatically makes the cell reference absolute!  By continuing to press F4, Excel will cycle 
through all of the absolute reference possibilities.  For example, in the first absolute cell 
reference formula in this tutorial, =B4*$B$10, we could have typed, =B4*B10, then pressed 
the F4 key to change B10 to $B$10.  Continuing to press F4 would have resulted in B$10, 

then $B10, and finally B10. Pressing F4 changes only the cell reference directly to the left of 
your insertion point. 

 
 

Challenge 

• Type the following information:  

In cell A1, type 12345 
In cell A2, type 15865 

In cell B1, type 9347 
In cell B2, type 11942 
In cell C1, type 19348 
In cell C2, type 17103 

• Create the following simple formulas:  

In cell A3, write a formula to add cell A1 and cell A2  
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• Fill the formula in cell A3 to both cell B3 and cell C3  
• Create the following complex formula:  

In cell A5, write a formula that divides cell A1 by the sum of cells A3, B3 and C3  

• In the formula defined in cell A5, create an absolute reference to all cells and rows 
referenced in the following part of the formula: sum of cells A3, B3 and C3.  

• Copy the formula and absolute reference in cell A5 and paste it into cell B5 and cell C5.  
• Note how the formulas that appear in cell A5, cell B5 and cell C5 differ from one another.  

 

 

 

 



 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Text Formatting 

You can format the text in your Word documents by 
changing the font style, size, color, character formatting, 

and text alignment. This document provides instructions for 
many different formatting options, such as experimenting 
with different fonts, boldfacing, and italicizing; these 
formatting options can give your document a unique look. 

 

Formatting Text 

Some rules to remember when formatting your text include 
the following: 

• If you know what formatting options you want, 

you can enable them before you type. After 
you finish typing the section, you can disable 
them. 

• When formatting text that is already typed 

into the document, the first step is to select it. 
Only selected text will take on the format that 
you are applying. For instructions, see 

Selecting Text in Editing a Document. 
• Using too many fonts, sizes, and other 

formatting in one document will usually cause 
it to look cluttered; a document with too much 

formatting may also be hard to read. Try to 
limit yourself to no more than two or three 
fonts, sizes, and formats per document. 

• Once the text is formatted, deselect the text 

by clicking away from the text or pressing an 
arrow key. Selected text is vulnerable and 
may be deleted or changed unintentionally! 
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7777    Functions 

Using Functions 

A function is a pre-defined formula that helps perform 
common mathematical functions. Functions save you the 

time of writing lengthy formulas. You could use an Excel 
function called Average, for example, to quickly find the 
average of range of numbers. Or you could use the Sum 

function to find the sum of a cell range. Excel XP contains 
many different functions. 

Each function has a specific order, called syntax, which 
must be strictly followed for the function to work 
correctly. 

Syntax Order: 

1. All functions begin with the = sign.  
2. After the = sign define the function name (e.g., 

Sum).  
3. One or more arguments-numbers, text or cell 

references-enclosed by parentheses. If there is 

more than one argument, separate each by a 
comma.  

An example of a function with one argument that adds a 
range of cells, B3 through B10: 
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An example of a function with more than one argument that calculates the average of 
numbers in a range of cells, B3 through B10, and C3 through C10: 

 

Excel literally has hundreds of different functions to assist with your calculations. Building 

formulas can be difficult and time-consuming. Excel's functions can save you a lot of time and 
headaches. 

Excel's Different Functions 

There are many different functions in Excel XP. Some of the more common functions include: 

Statistical Functions: 

• SUM - summation adds a range of cells together.  

• AVERAGE - average calculates the average of a range of cells.  

• COUNT - counts the number of chosen data in a range of cells.  
• MAX - identifies the largest number in a range of cells.  
• MIN - identifies the smallest number in a range of cells.  

Financial Functions: 

• Interest Rates  

• Loan Payments  
• Depreciation Amounts  

Date and Time functions: 

• DATE - Converts a serial number to a day of the month  

• Day of Week  
• DAYS360 - Calculates the number of days between two dates based on a 360-day year  
• TIME - Returns the serial number of a particular time  

• HOUR - Converts a serial number to an hour  
• MINUTE - Converts a serial number to a minute  
• TODAY - Returns the serial number of today's date  
• MONTH - Converts a serial number to a month  
• YEAR - Converts a serial number to a year  

You don't have to memorize the functions but should have an idea of what each can do for 
you. 

Finding the Sum of a Range of Data 

The AutoSum function allows you to create a formula that includes a cell range-many cells in 
a column, for example, or many cells in a row. 
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To Calculate the AutoSum of a Range of Data: 

• Type the numbers to be included in the formula in separate cells of column B (Ex: type 128 

in cell B2, 345 in cell B3, 243 in cell B4, 97 in cell B5 and 187 cell B6).  
• Click on the first cell (B2) to be included in the formula.  

• Using the point-click-drag method, drag the mouse to define a cell range from cell B2 
through cell B6.  

• On the Standard toolbar, click the Sum button.  
• The sum of the numbers is added to cell B7, or the cell immediately beneath the defined 

range of numbers.  
• Notice the formula, =SUM(B2:B6), has been defined to cell B7. 
 

 

Finding the Average of a Range of Numbers 

The Average function calculates the average of a range of numbers. The Average function can 
be selected from the AutoSum drop-down menu. 

To Calculate the Average of a Range of Data: 

• Type the numbers to be included in the formula in separate cells of column B (Ex: type 128 

in cell B2, 345 in cell B3, 243 in cell B4, 97 in cell B5 and 187 cell B6).  
• Click on the first cell (B2) to be included in the formula.  
• Using the point-click-drag method, drag the mouse to define a cell range from cell B2 

through cell B6.  
• On the Standard toolbar, click on the drop-down part of the AutoSum button. 
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• Select the Average function from the drop-down Functions list. 
 

 

• The average of the numbers is added to cell B7, or the cell immediately beneath the defined 

range of numbers.  
• Notice the formula, =AVERAGE(B2:B6), has been defined to cell B7. 
 

 

Using the MAX, MIN, and COUNT for a Range of Numbers 

The Max function obtains the maximum value while the Min function obtains the minimum 
value. The Count function counts the number of entries inputted.   

To use the MAX, MIN, and COUNT functions: 

• Type the numbers to be included in the formula in separate cells. For this example, the data 

inputted are as follows: 
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• Highlight cell B2 to cell B5 and click the drop-down part of the Auto Sum button and 
choose Max to obtain the highest number of the given range.  

 

 
 

• The highest number appears at cell B6.  
• Notice the formula, =MAX(B2:B5), has been defined to cell B6.  

 

 

• For getting the lowest number in column C, highlight cell C1 to cell C5 and go to drop down 

part of the Auto Sum button and choose Min. 
 

 

• The lowest number appears at cell C6.  
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• Notice the formula, =MIN(C2:C5), has been defined to cell C6. 
 

 

• To count how many entries does column D have, highlight cell D2 to cell D5 and from the 
Auto Sum button drop down list, choose Count. 

 

 
 

• The number of entries appears at cell D6. 

• Notice the formula, =COUNT(D2:D5), has been defined to cell D6.  
 

 

Using the IF Function 
 

The IF function can give your formulas decision making abilities.  

This function enables you to perform a calculation only IF a certain condition is true, and a 
completely different calculation if that condition is false. 
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The syntax (the fancy name for the order and sequence) for the Excel IF function is  

=IF(logical_test,value_if_true,value_if_false) 

where: 
 
logical_test is any value or expression that can be evaluated to TRUE or FALSE 

 
value_if_true is the value that is returned if logical_test is TRUE. If omitted TRUE is returned. 
 

value_if_false is the value that is returned if logical_test is FALSE. If omitted FALSE is 
returned. 

IF Function Example 

Let's say that we own a small grocery store that offers a home delivery service. It is obviously 
more efficient and profitable for us if we deliver fewer large orders than several small orders. 

We enter all the orders onto spreadsheets and if any person has orders totaling 500 or more in 
a calendar month we will give them a discount of 10% because we are extremely generous. 

 

As you can see in the example above, we have placed our IF function in cell C3, then 
subsequently copied it down through to cell C7 using Autofill. 

Using our syntax let's work through the formula.  

The logical_test asks "Is the value of cell B3 greater than (>) or equal to (=) 500?" 

value_if_true says "It's true! Enter 10% in the cell." 

value_if_false says "That's not true. Enter ‘Sorry! No discount.’ in the cell." 

Another way to perform the example above: 
 

• Position the cell pointer at cell C3. 

• Click the drop-down part of the Auto Sum button and choose More Functions. 
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• After clicking More Functions, the following window appears and choose IF. 
 

  
 

• Click OK and the following window appears. 
 

 
 

• As you fill the text boxes with arguments, notice the IF function slowly building its function call. 
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• Press OK and the result in C3 appear. 
 

  
 

• AutoFill cell C3 and obtain the following result. 
 

 
 

Accessing Excel XP Functions 
 
To Access Other Functions in Excel: 

• Using the point-click-drag method, select a cell range to be included in the formula.  

• On the Standard toolbar, click on the drop-down part of the AutoSum button.  
• If you don't see the function you want to use (Sum, Average, Count, Max, Min), display 

additional functions by selecting More Functions. 
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• The Paste Function dialog box opens.  
• There are three ways to locate a function in the Insert Function dialog box:  

You can type a question in the Search for a function box and click GO, or 

You can scroll through the alphabetical list of functions in the Select a function field, or 

You can select a function category in the Select a category drop-down list and review the 
corresponding function names in the Select a function field. 
 

 

• Select the function you want to use and then click the OK button.  

 

 



 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Text and Cell 

Alignment 

Using the Standard Toolbar to Align Text and 

Numbers in Cells 

You've probably noticed by now that Excel XP left-aligns 

text (labels) and right-aligns numbers (values). This 
makes data easier to read. 

 

  

You do not have to leave the defaults. Text and numbers 
can be defined as left-aligned, right-aligned or centered 
in Excel XP. The picture below shows the difference 
between these alignment types when applied to labels. 
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Text and numbers may be aligned using the left-align, center and right-align buttons of the 
Formatting toolbar: 

 

To Align Text or Numbers in a Cell: 

• Select a cell or range of cells  

• Click on either the Left-Align, Center or Right-Align buttons in the standard toolbar.  
• The text or numbers in the cell(s) take on the selected alignment treatment.  

Changing Horizontal Cell Alignment 

We've previously seen how to align text or numbers using the left-align, center and right-align 

buttons in the standard toolbar. You can also define alignment in the Alignment tab of the 
Format Cells dialog box. 

 

The Horizontal section features a drop-down that contains the same left, center, and 
right alignment options in the picture above and several more: 

Fill 

"Fills" the cell with the current contents by repeating the contents for the width of the cell. 

Justify 

If the text is larger than the cell width, Justify wraps the text in the cell and adjusts the 
spacing within each line so that all lines are as wide as the cell. 

Center Across Selection 

Contents of the cell furthest to the left are centered across the selection of cells. Similar to 
merge and center, except the cells are not merged. 

To Change Horizontal Alignment using the Format Cells Dialog Box: 

• Select a cell or range of cells.  
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• Choose Format Cells from the menu bar. 
 

 
 

(You could also right-click and choose Format Cells from the shortcut menu.)  
 
• The Format Cells dialog box opens.  
• Click the Alignment tab. 

 

 

• Click the Horizontal drop-down menu and select a horizontal alignment treatment.  
• Click OK to apply the horizontal alignment to the selected cell(s).  
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Changing Vertical Cell Alignment 

You can also define vertical alignment in a cell, similar to how it is done for horizontal 
alignment. In Vertical alignment, information in a cell can be located at the top of the cell, 
middle of the cell or bottom of the cell. The default is bottom. 

 

To Change Vertical Alignment using the Format Cells Dialog Box: 

• Select a cell or range of cells.  

• Choose Format Cells from the menu bar. 
 
(You could also right-click and choose Format Cells from the shortcut menu.) 

• The Format Cells dialog box opens.  

• Click the Alignment tab.  
• Click the Vertical drop-down menu and select a vertical alignment treatment.  
• Click OK to apply the vertical alignment to the selected cell(s).  

Changing Text Control 

Text Control allows you to control the way Excel XP presents information in a cell. There are 
three types of Text control: Wrapped Text, Shrink-to-Fit and Merge Cells. 

 

The Wrapped Text wraps the contents of a cell across several lines if it's too large than the 
column width. It increases the height of the cell as well. 

Shrink-to-Fit shrinks the text so it fits into the cell; the more text in the cell the smaller it 
will appear in the cell. 
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Merge Cells can also be applied by using the Merge and Center button on the standard 
toolbar. 

To Change Text Control using the Format Cells Dialog Box: 

• Select a cell or range of cells.  

• Choose Format Cells from the menu bar.  
• The Format Cells dialog box opens.  
• Click the Alignment tab.  

• Click on either the Wrapped Text, Shrink-to-Fit or Merge Cells check boxes-or any 
combination of them-as needed.  

• Click the OK button.  

Changing Text Orientation 

The fourth type of cell alignment in the Format Cells dialog box is Text Orientation, which 
allows text to be oriented 90 degrees in either direction up or down. 

 

To Change Text Orientation using the Format Cells Dialog Box: 

• Select a cell or cell range to be subject to text control alignment.  

• Choose Format Cells from the menu bar.  

• The Format Cells dialog box opens.  
• Click the Alignment tab.  
• Increase or decrease the number shown in the Degrees field or spin box.  
• Click the OK button.  

 
OR 

You can also click and drag the red point in the text pane to a new location indicating the 
orientation you want. The number in the Degrees field changes as you drag the pointer. 
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Example: 

 

From this action… 

 

 

Result: 

 

 

 

 

Challenge 

• Type any text you want in cell B2.  
• Change the row height of row 2 to 30.  
• Change the column width of column B to 20.  
• Apply a horizontal text alignment.  

• Apply a vertical text alignment.  
• Apply a text orientation of 90 degrees.  

 

Drag the red point. 



 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Formatting 

Numbers 

Formatting Numbers in the Format Cells Dialog 

Box 

Numbers in Excel can assume many different formats: 

Date, Time, Percentage or Decimals and even in Peso 
sign. 

To Format the Appearance of Numbers in a Cell: 

• Select a cell or range of cells.  

Choose Format Cells from the menu bar. 
 

 
(You could also right-click and choose Format Cells 
from the shortcut menu.) 
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The Format Cells dialog box opens.  

• Click the Number tab. 

 

 

• Click Number in the Category drop-down list. 
 

 

• Use the Decimal places scroll bar to select the number of decimal places (e.g., 2 would 
display 13.50, 3 would display 13.500).  

• Click the Use 1000 Separator box if you want commas (1,000) inserted in the number.  
• Use the Negative numbers drop-down list to indicate how numbers less than zero are to 

be displayed.  
• Click the OK button.  

Formatting Date in the Format Cells Dialog Box 

The date can be formatted in many different ways in Excel XP. Here are a few ways it can 
appear: 

October 6, 2003 
10/06/03 
10-Oct-03 

To Format the Appearance of a Date in a Cell: 
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• Select a cell or range of cells.  

• Choose Format Cells from the menu bar.  

• The Format Cells dialog box opens.  
• Click the Number tab.  
• Click Date in the Category drop-down list. 
 

 

• Select the desired date format from the Type drop-down list.  
• Click the OK button.  

Formatting Time in the Format Cells Dialog Box 

The time can be formatted in many different ways in Excel XP. Here are a few ways it can 
appear: 

13:30 
1:30 PM 

To Format the Appearance of Time in a Cell: 

• Select the range of cells you want to format.  

• Choose Format Cells from the menu bar.  
• The Format Cells dialog box opens.  

• Click the Number tab.  
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• Click Time in the Category drop-down list. 
 

 

• Select the desired time format from the Type drop-down list.  
• Click the OK button.  

Formatting Percentage in the Format Cells Dialog Box 

There may be times you want to display certain numbers as a percentage. For example, what 
percentage of credit cards bills account for your total monthly expenses? 

To Express Numbers as a Percentage in a Spreadsheet: 

• Select a cell or range of cells. 

 

 

• Choose Format Cells from the menu bar.  
• The Format Cells dialog box opens.  
• Click the Number tab.  



Lesson 12 – Formatting Numbers  85858585 

 

 
Building skills for success 

• Click Percentage in the Category drop-down list. 
 

 

• Define the Decimal Places that will appear to the right of each number.  

Click the OK button. 

 

 
 

Formatting Peso Sign in the Format Cells Dialog Box 

In dealing with money in our spreadsheet, we need to format the cells to fit it in our currency 
since there are no Peso sign available. 
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To Express Numbers with Peso sign in a Spreadsheet: 

• Select a cell or range of cells. 

 

 

• Choose Format Cells from the menu bar.  
• The Format Cells dialog box opens.  
• Click the Number tab.  

• Click Custom in the Category drop-down list. 
 

 

• Find the @ symbol by dragging down the scroll bar. 

• From the @ symbol, select the format as indicated in the diagram. 
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• In the Type box, replace the $ sign with P to format numbers in Pesos. 
 

  
 
• Press OK. 
The result will be like this. Adjust the column header to make your result presentable. 

 

 

Challenge 

• Type a Number in cell B2 and format it to have four decimal places.  

• Type a Date in cell B3 and format it to look like: October 6, 2003  
• Type a Time in cell B4 and format it to look like: 1:30:00 AM  

• Type a large number in cell B5 and a smaller number in cell C5. Then, in cell D5 define 
a formula to divide cell B5 by cell C5. Format the answer in cell D5 to be a Percentage 
with 1 decimal place.  

• Copy the answer of D5 and paste it in E5 and convert it into Peso sign. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Applying Font, 

Color, and Borders 

to Cells 

Change Font Type, Size and Color 

In Excel XP a font consists of three elements: Typeface, 
or the style of the letter; Size of the letter; and Color of 

the letter. The default font in a spreadsheet is Arial 10 
points, but the typeface and size can be changed easily. 

Selecting a Font Typeface: 

The amount of typefaces available for use varies 
depending on the software installed on your computer. 

 

To Apply a Typeface to Information in a Cell: 

• Select a cell or range of cells.  
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• Click on the down arrow to the right of the Font Name list box on the Formatting toolbar. 
 

 

• A drop-down list of available fonts appears. 

 

 

• Click on the Typeface of your choice.  
• The selection list closes and the new font is applied to the selected cells.  

 
To Apply a Font Size to Information in a Cell: 

The "Font Size" list varies from typeface to typeface. The Arial font sizes, for example, are 8, 
9, 10, 11, 12, 14, 16, 18, 20, 22, 24, 26, 28, 36, 48, 72. 

 

• Select a cell or range of cells.  



Lesson 13 – Applying Font, Color, and Borders to Cells  90909090 

 

 
Building skills for success 

• Click on the down arrow to the right of the font size list box on the Formatting toolbar. 
 

 

• A drop down list of available font sizes appears. 

 

 

• Click on the Font Size of your choice.  
• The selection list closes and the new font size is applied to the selected cells.  

 
To Apply Color to Information in Cells: 

• Select a cell or range of cells.  

• Click on the down arrow to the right of the font color list box. 
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• A drop-down list of available colors appear. 
 

 

• Click on the color of your choice.  
• The selection list closes and the new font color is applied to the selected cells.  

Underline, Italics and Bold 

In addition to the typeface, size and color, you can also apply Bold, italics, and/or underline 
font style attributes to any text or numbers in cells. 

To Select a Font Style: 

• Select a cell or range of cells.  

• Click on any of the following options on the Formatting toolbar. 
 

 

• Bold button (Ctrl + B).  

• Italics button (Ctrl + I).  
• Underline button (Ctrl + U). 

• The attribute(s) selected (bold, italics, or underline) are applied to the font.  
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The Bold, Italics, and Underline buttons on the Formatting toolbar are like toggle 
switches. Click once to turn it on, click again to turn it off. 

Design and Apply Styles 

Styles can save a lot of time when formatting a spreadsheet. A Style is a unique collection of 

font attributes (Number, Alignment, Font, Border, Patterns and Protection). Many different 
styles can be created in a spreadsheet, each with different attributes and names. When applied 
to a cell, information in it resembles the attributes defined for that style. 

To Apply a style: 

• Select the cell or range of cells.  

• Choose Format Style from the menu bar. 

 

 

• Select a style from the Style name drop-down list. 
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You can change the style attributes (Number, Alignment, Font, Border, Patterns and 
Protection) for any Style Name. 

You can create new styles by clicking on the Add button in the Style dialog box. 

Adding a Border to Cells 

Borders can be applied to cells in your worksheet in order to emphasize important data or 
assign names to columns or rows. 

To Add a Border to a Cell or Cell Range: 

• Select a cell or range of cells.  

• Click on the down arrow next to the Borders button.  
• The Border drop-down appears. 
 

 

• Choose a borderline style from the Border drop-down menu. 
 

 

• The selected cells display the chosen border.  
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Adding Color to Cells 

Colors can be applied to cells in your worksheet in order to emphasize important data or 
assign names to columns or rows. 

To Add Color to a Cell: 

• Select a cell or range of cells.  

• Click the down arrow next to the Font Color button. A Font Color drop-down menu 
displays. 
 

 

• Choose a font color from the Font Color drop-down menu. 

 

 

• The selected cells display the color.  
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Challenge 

• Type the label, "Learning about fonts in Excel," in cell B2.  

• Change the font in cell B2 to have a typeface of Times New Roman, a size of 16 and a 
color of red.  

• Type the word, "Underline," in cell B3 and apply an underline treatment to it.  
• Type the word, "Italics," in cell B4 and apply an italics treatment to it.  
• Type the word, "Bold," in cell B3 and apply a bold treatment to it.  
• Select a cell range that includes cells B2, B3, B4 and B5.  

• Add a border around the cell range.  
• Define a color of yellow around the cell range.  

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Copying and 

Deleting 

Formatting 

New features included in Office XP applications is the 
Format Painter that allows you to copy the formatting to 

other texts and values without going through again to 
formatting process.  

Formatting with the Painter: Single Cell  

1. Select the cell that contains the formatting you want 

to copy  
2. On the Standard toolbar, click FORMAT PAINTER 

 
The pointer changes shape to include a paint brush 
next to it.  

3. Click the cell to which you want the copied format 
applied 

NOTE: You can also select a range of cells by clicking 
and dragging.  

Example:  
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After the Format Painter is clicked, click on cell D4 and the formatting in cell C4 is then copied.  
  

  

Formatting with the Painter: Multiple Cells  

1. Select the cell that contains the formatting you want to copy  

2. On the Standard toolbar, double click FORMAT PAINTER  

The pointer changes shape to include a paint brush next to it.  
3. Click the cell where you want the copied format applied 

You can also select a range of cells by clicking and dragging.  
4. Repeat step 3 for additional cells in which you want the format applied  

5. When done, to turn off the Painter, click FORMAT PAINTER again 

Clearing All Formatting from a Cell  

If you want to remove all formatting from a cell but leave the contents (text, value, or 
formulas), use the following command.  

1. Select the cells that you want to clear the formatting from  
2. From the Edit menu, select Clear » Formats  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Creating a Chart 

Charts are graphical representations of worksheet data. You 
can use charts to present complicated data to people who 

want to interpret the data quickly.  

When you create a chart, you can either embed it in a 

worksheet, or create a new chart sheet in the workbook. If 
the chart is in a separate sheet, you can set it up with its 
own printing options, such as wide carriage or in color.  

Understanding the Different Chart Types 

Excel XP allows you to create many different kinds of 
charts. 

Area Chart 

An area chart emphasizes the trend of each value over 

time. An area chart also shows the relationship of parts 
to a whole. 

 

Column Chart 

A column chart uses vertical bars or columns to display 

values over different categories. They are excellent at 
showing variations in value over time. 
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Bar Chart 

A bar chart is similar to a column chart except these use horizontal instead of vertical bars. 
Like the column chart, the bar chart shows variations in value over time. 

 

Line Chart 

A line chart shows trends and variations in data over time. A line chart displays a series of 
points that are connected over time. 

 

Pie Chart 

A pie chart displays the contribution of each value to the total. Pie charts are a very effective 

way to display information when you want to represent different parts of the whole, or the 
percentages of a total. 
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Other Charts 

Other charts that can be created in Excel XP include: Doughnut; Stock XY (scatter); 
Bubble; Radar; Surface; or Cone, Cylinder, and Pyramid charts. 

Creating Charts  

Excel has a special feature called the Chart Wizard to help you create charts in your 

workbooks. The Chart Wizard is a series of dialog boxes; from each dialog box you choose the 
options you want, then the Chart Wizard creates the chart based on the choices you make.  

Figure 1. To create a chart, select the data you want Excel to plot, then click on the Chart 
Wizard button on the Standard toolbar. 

  

 

  

Figure 2. After you click on the Chart Wizard button, Excel opens the Chart Wizard - Step 

1 of 4 - Chart Type dialog box. The title bar in each Chart Wizard dialog box lets you know 
which step you are up to. In the first step, you choose the chart type. You can choose a 
standard type from the Standard Types tab, or a custom type from the Custom Types tab.  

On the Standard Types tab, from the Chart type box, select the type of chart you want to 
create, then from the Chart sub-type section, choose a sub-type. Once you have selected a 

sub-type, you can see how your chart will look by clicking on the Press and hold to view 
sample button. 
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Figure 3. The Custom Types tab lets you choose a custom chart type. There are a number of 
built-in custom types, or you can define your own. The built-in custom types also contain 
custom formatting. 

  

Figure 4. After you have selected a chart type, you can quickly create the chart by clicking on 
the Finish button. If you do this, the Chart Wizard creates your chart using default settings.  

If you would prefer to customize your chart with the help of the Chart Wizard, you should click 
on the Next button in the first Chart Wizard dialog box. 
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Figure 5. After you click on the Next button, Excel opens the Chart Wizard - Step 2 of 4 -

Chart Source Data dialog box. In this step, you specify which source data you want to use in 
your chart.  

On the Data Range tab, Excel indicates the cells you selected in the worksheet. If these are 
not the cells that you want to base your chart on, change the cell range. To do this, you can 
type a new range into the Data range text box, or you can select a new range from the 

worksheet. If you want to select the new range from the worksheet, you will probably have to 
collapse the dialog box so that you can see the data you want to select. To collapse the dialog 
box, click on the collapse button at the right-hand end of the Data range text box. 
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Figure 6. After you click on the collapse button, the dialog box collapses. All that remains is 
the title bar and the Data range text box. You can now select data directly on the worksheet. 
To expand the dialog box, click on the collapse button again. 

 

Figure 7. The Series tab lets you change the series for the chart. If the sample is how you 

want the chart to look, then you don't need to make any changes. If the sample shows that 

the series in your chart will not be the way you want them, you can change them here. You 
can also add and delete series using the options on this tab. Each text box contains a collapse 
button so that you can collapse the dialog box if you need to.  

When the chart source data is as you want it, all you have to do is click on the Next button. 
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Figure 8. Excel then opens the Chart Wizard - Step 3 of 4 - Chart Options dialog box. This 
dialog box contains six tabs which let you choose options for different parts of the chart.  

The Titles tab lets you add titles to the chart. Type into the appropriate text boxes any titles 

that you want to appear on the chart; the preview chart shows how they will look. When you 
have added any titles you want to include, click on the Axes tab. 

 

Figure 9. The Axes tab lets you turn standard axes options on and off. When you select or 
de-select an option, make sure you check the preview chart.  

When the preview chart is as you want it, click on the Gridlines tab. 
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Figure 10. The Gridlines tab contains options that let you turn the chart's gridlines on and 
off.  

When the preview chart is as you want it, click on the Legend tab. 

 
 

Figure 11. The Legend tab lets you specify whether or not you want your chart to have a 
legend. If you choose to have a legend, you can then choose its position.  

When the preview chart is as you want it, click on the Data Labels tab. 
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Figure 12. You can add data labels to the markers in your chart. Data labels show the value 
represented by each chart marker. The Data Labels tab lets you specify whether or not you 
want to include data labels in your chart.  

When the preview chart is as you want it, click on the Data Table tab. 

 

Figure 13. A data table is a grid that appears below a chart. The data table contains the data 

on which the chart is based. The Data Table tab lets you specify whether or not you want to 
include a data table with your chart.  

When the preview chart is as you want it, click on the Next button.  
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Figure 14. Excel then opens the Chart Wizard - Step 4 of 4 - Chart Location dialog box. In 
this step, you specify whether you want the chart to be embedded as an object on an existing 

worksheet, or as a new sheet that contains only the chart. In this example, we are inserting 
the chart as an object on Sheet2 of our workbook.  

When you have specified where you want the chart to go, click on the Finish button. 

 

Figure 15. The Chart Wizard then creates the chart and opens the Chart toolbar. You can dock 
the Chart toolbar at any edge of the window, or leave it as a floating toolbar.  

You can see in this figure that the chart is too small to display properly, so the first thing we 
want to do is resize it. To resize a chart, click on one of the sizing handles and drag. 

 

Figure 16. As you drag, a dashed outline shows the new size of the chart. When the outline is 
the size you want the chart, release the mouse button.  

If you make the chart broader or taller, the shape of the graph will change proportionally, but 
the shape and size of the text in the chart labels will not be affected. 
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Figure 17. You can move the chart by dragging it to a new position. As you drag, a dashed 

outline shows the new position. When the chart is where you want it, release the mouse 
button. 

 
   

Chart Items  

Figure 18. Now that we have created a chart, let's look at the items that make up the chart. 
You can edit, format, and hide most of these items. 
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 Challenge 

• Type the following information on the worksheet:  

In cell A2, type January 
In cell A3, type February 

In cell A4, type March 
In cell B1, type Bill 
In cell B2, type 3542 
In cell B3, type 7184 

In cell B4, type 6531 
In cell C1, type Mary 
In cell C2, type 2943 

In cell C3, type 6542 
In cell C4, type 7137 
In cell D1, type Bob 
In cell D2, type 3403 

In cell D3, type 7314 
In cell D4, type 6942 

• Create an embedded Line Chart showing the numbers on the Y-axis and the months on 
the X-axis. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Modifying Charts 

Once you have created a chart, you can modify it in a 
number of ways. Sometimes the easiest way to modify a 

chart is to re-open the dialog boxes that you used in the 
Chart Wizard when creating the chart. There are also other 
ways to modify charts, but before you can change chart 
items, you must know how to select them.  

 Selecting Chart Items  

Figure 1. Before you can modify a chart item, you must 

select it. To do this, click on the chart item. In this example, 
we have clicked on the legend.  

After you click on an item, the item's name is displayed in 
the name box and in the Chart Objects box on the Chart 

toolbar. To see the name of an item, move the mouse 
pointer over the item and leave it there for a few seconds. 
The item's name displays as a ScreenTip. 
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Figure 2. You can also select chart items using the Chart Objects box on the Chart toolbar. 
To do this, click on the chart, then click on the down arrow beside the Chart Objects box. This 

displays a list of the chart items. Select the item you want from the list.  

  

 

 

Changing the Chart Type  

Figure 3. To change the chart type, right-click on the chart area, then from the submenu that 
appears select the Chart Type command. 
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Figure 4. Excel then opens the Chart Type dialog box. Choose the chart type you want, then 
click on the OK button.  
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Figure 5. You can also change the chart type using the Chart Type button on the Chart 
toolbar. This displays a menu of chart type options. You can drag this menu away from the 
toolbar to leave it floating on the screen. 

  

 

Changing Chart Options  

Figure 6. When you created your chart using the Chart Wizard, the Chart Options dialog 
box let you add various items, such as titles, gridlines, data labels, and a legend. You can add 

or remove these items after you have created the chart by re-opening the Chart Options 
dialog box. To do this, right-click on the chart area and from the shortcut menu that appears, 
select the Chart Options command. 
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Figure 7. This opens the Chart Options dialog box where you can add or remove chart items.  

  

 

Changing Chart Values  

Excel automatically links charts to the source data used to create them, so it is very easy to 

change the values represented by the chart-all you have to do is edit the worksheet data on 

which the chart is based. As soon as you edit the worksheet data, Excel updates the chart. This 
ensures that charts constantly reflect current worksheet data.  

   

Adding Chart Data  

After you have created a chart you may find that you need to add more data to it. You can do 
this in a number of ways.  

Adding data using drag-and-drop  

You can add data to embedded charts by dragging new source data from the worksheet onto 

the chart. The chart then automatically updates. You cannot use this method to update chart 
sheets.  

Figure 8. In this example, our chart shows the number of home units sold by three real estate 
agents. We have added the sales for another agent to our worksheet data and want to add this 
to the chart. We can do this by dragging the data onto the chart.  

Select the data in the worksheet, then move the mouse pointer over an edge of the selection 

until it becomes an arrow, then drag the selection onto the chart area. The mouse pointer then 
displays a small plus sign (+) to show that you are copying data onto the chart. To add the 
new data, release the mouse button. 
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Figure 9. After you drop the new data onto the chart, Excel automatically updates it. 
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Adding Data Using Copy and Paste  

Figure 10. To add data to an embedded chart or a chart sheet, you can copy the data from 
the worksheet and paste it into the chart. To do this, select the data you want to add, then 
click on the Copy button on the Standard toolbar. 

  

  

Figure 11. When you have copied the data, select the embedded chart, or switch to the chart 
sheet, and click on the Paste button on the Standard toolbar. 
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Figure 12. Excel then pastes the data into the chart. In this example, you can see that Excel 
has added the data to our chart sheet. 

  

   

Deleting Chart Data  

To delete data from a chart, all you have to do is delete the corresponding data from the 
worksheet.  

Figure 13. If you want to delete a data series from a chart but leave the corresponding data 
intact in the worksheet, select the data series on the chart, then press the Delete key. 
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 Challenge 

• Type the following information on the worksheet:  

In cell A2, type Bill 
In cell A3, type Bob 
In cell A4, type Mary 

In cell B1, type Phones 
In cell B2, type 7630 
In cell B3, type 2943 
In cell B4, type 2301 

In cell C1, type Cables 
In cell C2, type 9873 
In cell C3, type 3745 

In cell C4, type 2019 
In cell D1, type Internet 
In cell D2, type 8374 
In cell D3, type 2049 
In cell D4, type 4038 

• Create an embedded Bar Chart that plots Bill, Bob and Mary on the Y- axis. The Legend 
will comprise Phones, Cables and Internet.  

• Change any of the numbers in the Data Source (cells B2, B3, B4, C2, C3, C4, D2, D3 or 
D4) and notice how the chart changes.  

• Change any Data Series Name (Bill, Bob or Mary) or Legend Value (Phones, Cable or 
Internet) and notice how the chart changes.  

• Change the Chart Type from a Bar Chart to a Line Chart.  

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Formatting Charts 

After you have created a chart, you can format its items to 
improve its appearance and emphasize data.  

Many chart items share common formatting options, for 
example, the formatting dialog boxes for data labels, data 

tables, and chart titles all contain a Font tab which lets you 
format the text associated with those chart items. The 
formatting features which are common to more than one 

chart item are covered in this lesson under the heading 
Common Formatting.  

Some chart items, such as the chart area and data series, 
have special formatting that applies only to that item. These 
formatting features are covered in this lesson under the 
heading Special Formatting.  

Common Formatting  

To format a chart item, you open a dialog box that contains 

tabs with formatting options which are relevant to that item. 
The Patterns, Font, Number, Alignment, and Scale tabs 

are all relevant to more than one chart item, so we have 
grouped them together as common formatting features. 

Figure 1. To open a chart item's formatting dialog box, 
right-click on the item and then choose the Format 
command from the shortcut menu. The Format command 

includes the name of the item; in this example, we clicked 
on the chart title, so we choose the Format Chart Title 
command from the shortcut menu.  
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Patterns  

The Patterns tab of the Format dialog box lets you add borders, colors, and fill effects to the 
following chart items:  

• the chart area;  
• the plot area;  
• the data table;  

• the legend;  
• data series;  
• data labels;  

• chart titles;  
• gridlines;  
• axes.  

To format one of these chart items with borders, colors, or fill effects, right-click on the item 
and select the Format command.  

Figure 2. After you select an item's Format command, Excel opens the Format dialog box. 

Now click on the Patterns tab to display it. In this example, we have opened the Patterns tab 
of the Format Chart Title dialog box. 
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Borders  

Figure 3. The Border section of the Format dialog box lets you add a border to the selected 

chart item. You can choose the style, color, and weight of the border. The Sample section of 
the dialog box shows what the border will look like if you apply the current options to the chart 
item.  

  

Colors  

Figure 4. The Area section lets you fill the area of the selected chart item with color. Click on 
the color you want. 
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Fill effects  

Figure 5. You can add special textures and gradient fills to the area of the selected chart item. 
To do this, click on the Fill Effects button. 

  

Figure 6. After you click on the Fill Effects button, Excel opens the Fill Effects dialog box. 
This lets you add a gradient fill, texture, pattern, or picture to the selected chart item.  

The Gradient tab lets you add a gradient, or gradually shaded fill, to the selected chart item. 
From the Colors section, choose whether you want a one-color, two-color, or preset fill. In this 

example, we have clicked on the Preset radio button and chosen the Early Sunset option 
from the Preset colors box. Next, choose an option from the Shading styles section, then 
choose one of the options from the Variants section. The Sample section shows what your 
chart item will look like if you apply the currently selected options. 
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Figure 7. The Texture tab of the Fill Effects dialog box lets you add a texture to the selected 
chart item. You can choose from the built-in textures, or if you have your own texture you can 
open that by clicking on the Other Texture button.  

The Sample section shows what your chart item will look like if you apply the currently 
selected texture. 

  

Figure 8. The Pattern tab of the Fill Effects dialog box lets you add a pattern to the selected 
chart item. From the Pattern options, choose the pattern you want, then from the 
Foreground and Background boxes choose the colors you want.  

The Sample section shows what your chart item will look like if you apply the currently 
selected pattern. 
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Figure 9. The Picture tab of the Fill Effects dialog box lets you use a picture as a fill for the 
selected chart item. The picture will stretch to fill the chart item.  

To add a picture, click on the Select Picture button, then from your own files, select the 

picture you want to use as a fill. The Sample section shows what your chart item will look like 
if you apply the currently selected picture.  

When you have chosen the fill effect you want, click on the OK button in the Fill Effects dialog 
box. 

  

Figure 10. Excel then returns you to the Format dialog box. To apply the formatting options 
you chose, click on the OK button. 
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Font  

The Font tab of the Format dialog box lets you format the text of the following chart items:  

• the chart area;  
• the data table;  
• the legend;  

• data labels;  
• chart titles;  
• axes.  

To format the text of one of these chart items, right-click on the item and select the Format 
command.  

Figure 11. After you select an item's Format command, Excel opens the Format dialog box. 

In this example, we have opened the Format Legend dialog box. Now click on the Font tab to 
display it.  

Select the options you want for the text of the selected chart item. The Preview section shows 
what the text will look like if you apply the currently selected options to the chart item. To 
apply the options, click on the OK button.   

 

 Alignment  

The Alignment tab of the Format dialog box lets you align the text of the following chart 
items:  

• chart titles;  
• data labels;  
• axes.  
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To align the text of one of these chart items, right-click on the item and select the Format 
command.  

Figure 12. After you select an item's Format command, Excel opens the Format dialog box. 

In this example, we have opened the Format Axis dialog box. Now click on the Alignment 
tab to display it.  

The alignment options vary depending on which chart item you are formatting. In this 
example, we have used the Degrees spin box to rotate the text of the category axis. Let's now 
see what happens when we click on the OK button. 

  

Figure 13. You can see that Excel has rotated the text on the category axis.  
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Number  

The Number tab of the Format dialog box lets you format the numbers of the following chart 
items:  

• data labels;  
• axes.  

To format the numbers of one of these chart items, right-click on the item and select the 
Format command.  

Figure 14. After you select an item's Format command, Excel opens the Format dialog box. 
In this example, we have opened the Format Axis dialog box. Now click on the Number tab 
to display it.  

You can select a different number format from the category list. When you select a different 
category, the link between the chart and the worksheet data is broken, and the Linked to 

source check box is cleared. To re-establish the link, select the Linked to source check box. 
Choose the options you want, then click on the OK button. 

  

 

Scale  

The Scale tab of the Format dialog box lets you adjust the scale of the following chart items:  

• gridlines;  
• axes.  

To adjust the scale of one of these chart items, right-click on the item and select the Format 
command.  
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Figure 15. After you select an item's Format command, Excel opens the Format dialog box. 
In this example, we have opened the Format Gridlines dialog box. Now click on the Scale tab 
to display it.  

The options on the Scale tab of the Format Axis dialog box vary depending on which axis you 
select.  

Change the options you want to change, then click on the OK button. 

 

  

Special Formatting  

So far we have looked at the formatting options which are relevant to more than one chart 

item. Some chart items have their own special formatting options. These special options are 
discussed below. Remember that to open an item's Format dialog box, right-click on the item 
and from the submenu that appears, select the Format command.  

Chart area  

Figure 16. This figure shows the Format Chart Area dialog box. For information about the 

first two tabs, see Patterns and Font earlier in this chapter. The options on the Properties 
tab are described here.  

The Object positioning section lets you specify how you want the chart to be positioned in 
relation to the worksheet. If you want the chart to print when you print the worksheet, select 
the Print object check box.  

The Locked check box lets you protect the chart from changes. When you have selected the 
options you want, click on the OK button. 
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Legend  

Figure 17. This figure shows the Format Legend dialog box. For information about the first 
two tabs, see Patterns and Font earlier in this chapter.  

The options on the Placement tab let you position the legend where you want it. Choose an 
option from the Type section, then click on the OK button. 

  

 

Data series  
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Figure 18. There are a number of formatting options that are unique to the data series in your 
charts. To format a data series, right-click on one of its data markers, then from the submenu 
that appears, select the Format Data Series command. 

  

Figure 19. This figure shows the Format Data Series dialog box. For information about the 

first tab, see Patterns earlier in this chapter. The Axis tab lets you plot the data on the 
primary axis, or a secondary axis. The sample chart shows the effect of each option when you 
select it. 

  

 

Figure 20. The Y Error Bars tab lets you add lines that illustrate potential error amounts for 
a data series. Choose the options you want, then click on the OK button.  
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For help with an option, click on the question-mark button in the top-right corner of the dialog 
box, then click on the option. 

  

Figure 21. The Data Labels tab lets you customize data labels in a chart. Choose the options 
you want, then click on the OK button.  

For help with an option, click on the question-mark button in the top-right corner of the dialog 
box, then click on the option. 

  

Figure 22. The Series Order tab lets you change the order of the data series in a chart. From 
the Series order list box, select the series you want to move, then click on the Move Up or 
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Move Down button. The sample chart shows what your chart will look like if you apply the 
selected options. 

  

Figure 23. The Options tab lets you change the way the data markers of a series are 
displayed. For example, you can make the markers overlap and you can increase the amount 
of space between the markers.  

For help with an option, click on the question-mark button in the top-right corner of the dialog 
box, then click on the option.  

When the sample chart is as you want it, click on the OK button to apply the changes. 
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Hiding and Displaying Chart Items  

Figure 24. You have the option of displaying or hiding most chart items, including titles, axes, 
gridlines, data labels, the legend, and the data table. To hide an item, right-click on it and from 
the shortcut menu that appears select the Clear command. 

  

Figure 25. To display an item, right-click on the chart area and from the shortcut menu that 

appears select the Chart Options command. Excel then opens the Chart Options dialog box 
where you can choose the items you want to display.  

  

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Table 

In the days of the typewriter, fonts were monospace 
characters (i.e., spaces between characters were equal). 

Now, computers use proportional space fonts (i.e., 
characters and spaces use only the amount of space that 
they need). With monospace fonts we could press the space 
bar to align text, but when we try that with proportional 

space fonts, we often end up with undesired results, even if 
it looks good on the screen. 

To avoid problems with text lining up, use tabs instead of 
spaces. The default tab settings for Microsoft Word are every 
half-inch. If you do not like the Word settings, you can set 

your own tabs. 

Tab Types 

Tabs come in different types which are defined by the way 

text lines up with the tab. The following table explains the 
different tab types. 
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Worksheets 

Naming Worksheets 

At the beginning of this course, we learned that the tabs 
displayed at the bottom of the screen are named Sheet1, 

Sheet2 and Sheet3. These are not very informative 
names. Excel XP allows you to define a meaningful name 
for each worksheet in a workbook-Checkbook, Reports, 
Accounts-so you can quickly locate information. 

To Name a Worksheet: 

• Double-click the sheet tab to select it. The text 

is highlighted by a black box. 
 

• Type a new name for the worksheet. 
 

• Press the Enter key.  
• The worksheet now assumes the descriptive 

name defined.  
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Inserting Worksheets 

By default, each new workbook in Excel XP defaults to three worksheets named Sheet1, 
Sheet2 and Sheet3. You have the ability to insert new worksheets if needed or delete others 
you no longer want. 

To Insert a New Worksheet: 

• Choose Insert Worksheet from the menu bar. 

 

 

• A new worksheet tab is added to the bottom of the screen. It will be named Sheet4, Sheet5 
or whatever the next sequential sheet number may be in the workbook.  

Deleting Worksheets 

Any worksheet can be deleted from a workbook, including those that have data in it. 
Remember, a workbook must contain at least one worksheet. 

To Delete One or More Worksheets: 

• Click on the sheet(s) you want to delete.  
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• Choose Edit Delete Sheet from the menu bar. 
 

 

• The following dialog box appears if the sheet being deleted contains information on it. 
 

 

• Click the Delete button to remove the worksheet and all the data in it.  

Another way to delete or insert a worksheet is to right-click on the sheet to be deleted and 
then select Delete or Insert from the shortcut menu. 
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Grouping and Ungrouping Worksheets 

A workbook is a multi-page Excel document that contains multiple worksheets. Sometimes 
you will want to work with the worksheets one at a time as if each is a single unit. Other times, 

the same information or formatting may need to be added to every worksheet. You can type 
and retype the same information in each worksheet, or apply identical formatting, or you can 
group the worksheet and enter the information once. 

Worksheets can also be combined together into a group. Grouping worksheets allows you to 

apply identical formulas and/or formatting across all the worksheets in the group. When you 
group worksheets, any changes made to one worksheet will also be changed in any other 
worksheets in the group. If many worksheets are to have the same data--regions, 
departments, quarters, months, weeks and days, for example--then you type it once and it will 
appear on every worksheet included in the grouping. 

 

To Group Worksheets: 

• To select one worksheet, click on the sheet tab.  

• To select more than one worksheet, hold the Control key down and click on one or more 
worksheet tabs in the workbook.  

• To select all worksheets in a workbook, right-click on any worksheet tab and choose Select 
All Sheets from the shortcut menu.  

When finished entering, moving, copying or formatting the data, you will need to ungroup 
worksheets. If you do not ungroup the sheets, any work you do in one sheet will be duplicated 
in all the others. 

To Ungroup Worksheets: 

• Right-click on any of the selected worksheet tabs.  
• Choose Ungroup Sheets from the shortcut menu.  
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Moving Worksheets 

When you move a sheet, you are moving it to a new location in this or another workbook. 

To Move a Workbook: 

• Select the worksheet you want to move/copy.  

• Choose Edit Move or Copy from the menu bar. 

 

 

• In the Move or Copy dialog box, use the drop down boxes to select the name of the 
workbook you will move the sheet to (the current workbook is the default). Also define 
where you want the sheet positioned in the workbook. 
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• Check Create a copy to copy it.  
• Click the OK button to move the worksheet to its new location.  

 

Copying Worksheets 

When you copy a sheet, you make an exact copy of it. 

To Copy a Worksheet: 

• Select the worksheet you want to move/copy.  

• Choose Edit Move or Copy from the menu bar.  
• In the Move or Copy dialog box, use the drop down boxes to select the name of the 

workbook you will copy the sheet to (the current workbook is the default). Also define 
where you want the sheet positioned in the workbook.  

• Click the Create a copy checkbox. 

 

 

• Click OK to create an exact copy of the worksheet and move it to the location specified.  

Moving and Copying Worksheets 

To move a worksheet to a new location in the current workbook, use your mouse to drag and 
drop the sheet tab: 

1. Press and hold the mouse button over the sheet tab for the worksheet you want to move.  
2. Holding down the mouse button, drag the mouse to the new location.  

 

3. Release the mouse button.  

The sheet tab for the worksheet appears in the new location. 
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You can also copy the worksheet to a new location by holding down Ctrl key while you drag 
the sheet tab. To copy multiple sheets, press Ctrl while you select each sheet and then 
release the Ctrl key. Then press the Ctrl key again and, holding it down, drag the group of 
sheet tabs to the new location. 

 

Finally, release the mouse button, and then release the Ctrl key. The sheets are copied to the 
new location. 

 

 
To move or copy worksheets to a different workbook: 

1. Open both workbooks—the one that currently contains the worksheets and the one that 
you want to move or copy the worksheets to.  

2. Activate the workbook that currently contains the worksheets by clicking its button on the 
Windows taskbar.  

 

3. Select the sheets you want to move or copy.  
4. From the Edit menu, select Move or Copy Sheet, or right-click the appropriate sheet tab 

(or group of selected tabs) and select Move or Copy from the shortcut menu.  

The Move or Copy dialog opens. 
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5. From the To book drop-down menu, select the workbook you want to move or copy the 
worksheet(s) to.  

Tip: 

You can move or copy the sheets to a new workbook by selecting (new book) instead. 

6. Under Before sheet, select the location in the workbook where you want to move or copy 
the sheets. The sheets will appear before the worksheet you select here.  

7. To copy the worksheets to the new location, check the Create a copy checkbox, and then 
click OK.  

To move the worksheets, leave the box unchecked and simply click OK. 

 

Coloring Tabs 
 
Changing the Tab Color: Menu Option  

1. From the Format menu, select Sheet » Tab Color... 

 
The Format Tab Color dialog box appears. 

 
 
2. Select the desired color 
3. Click OK 

Changing the Tab Color: Mouse Option 

1. Right click the appropriate SHEET tab » select Tab Color... 
 

 
The Format Tab Color dialog box appears. 
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2. Select the desired color 
3. Click OK 

Protecting a Worksheet 

When you protect a worksheet, you prevent users from viewing or making changes to the 
contents, depending on the protection options you use: 

• If you want to prevent users from viewing certain rows or columns, hide them before you 
protect the worksheet using the Hide command in the Format Rows or Columns 
submenu.  

• If you want to prevent users from viewing formulas in particular cells:  

1. Select the cells whose formulas you want to hide.  
2. From the Format menu, select Cells.  

The Format Cells dialog opens. 

3. Select the Protection tab.  

 

4. Check the Hidden checkbox.  
5. Click OK.  

• If you want users to be able to enter or edit data into certain cells, but not others, you 
must unlock those cells you want them to be able to use before you protect the worksheet:  

 
1. Select the cells you want users to be able to edit.  
2. From the Format menu, select Cells.  
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The Format Cells dialog opens. 

3. Select the Protection tab.  

 

4. Uncheck the Locked checkbox.  
5. Click OK.  

Once you've set the properties you want for the individual rows, columns, and cells in the 
worksheet, you can protect the worksheet. To do so: 

3. From the Tools menu, select Protection, and then select Protect Sheet from the 
submenu.  

The Protect Sheet dialog opens. 
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2. To protect the contents of the worksheet, with the exception of any cells you unlocked, 
make sure the Contents checkbox is checked.  

3. Selecting Objects protects graphics, charts, and comments in the worksheet.  
4. Selecting Scenarios prevents users from changing and deleting scenarios.  
5. To password-protect the worksheet, enter a password into the Password field.  

You'll be prompted to re-enter the password. Do so to confirm the password and click OK. 

6. Click OK.  

To remove protection from a worksheet, select Protection and then Unprotect Sheet from 
the Tools menu. If you entered a password when you protected the sheet, you'll be prompted 
to re-enter it now. Do so, and then click OK. 

Protecting Entire Workbook 
 
You can also protect the entire workbook, including all sheets and the window size. 

 
1.  Click on Tools, Protection, Workbook. 
2.  Enter desired password.   
3. Click on OK. 
4. A new window appears to re-enter your password and type again the password. 
5. Click OK. 
6. Save the file to update changes.  
 



 

 

 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

Freezing Panes 

and Grouping 

Columns and 

Rows 

Freezing the Panes  

The Freeze Panes option is often used when you have 
several columns or rows grouped together. In this situation, 

if you go beyond one screen of information, you generally 
lose the row or column headings so you may not know what 
the information that you are looking at refers to. With the 

Freeze Panes option, you can freeze either, or both, the rows 
or the columns. This means that, regardless of where you 
are in the worksheet, you can see the information in that 
row and/or column at all times. 

1. Select the first cell that you want to freeze 
This should be the cell immediately below the last row 
of the title and to the right of the last column of the 
title. 

2. From the Window menu, select Freeze Panes 

Unfreezing Panes 

1. From the Window menu, select Unfreeze Panes 

In our example, we've selected cell A2 which is just below 
the "Order ID" heading. 
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Now when you scroll down, you should still continue to see the column headings. 

Grouping and Ungrouping Columns and Rows 

Grouping columns and Widths are ways to cover data in a worksheet. 
 
To group columns: 

 
1. Highlight the desired column headers. 
2. Select Data >> Group and Outline >> Group. 

Each dot appears above the selected column headers and above it is a bar with a “ – “ 

sign. 
3. Click the “ – “ sign to cover data.  

The column headers are now covered and the “ - ” sign becomes “ + ” sign that 

when clicked will open up to its previous view.  
 
To ungroup columns: 
 

1. Open up the covered columns. 
2. Highlight the columns headers. 
3. Select Data >> Group and Outline >> Ungroup. 

The dots and bar disappears. 
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Example:  After following directions in To group columns section, notice the each dot above 
Column Headers B to D and the bar above it. 
 

  
 
Clicking the “ - ” sign will result into this. 

 

 
 
Ungrouping the columns will return to its previous view. 
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To group rows: 
 

4. Highlight the desired row guides. 
5. Select Data >> Group and Outline >> Group. 

Each dot appears beside the selected row guides and beside it is a bar with a “ – “ sign. 
6. Click the “ – “ sign to cover data.  

The row guides are now covered and the “ - ” sign becomes “ + ” sign that 
when clicked will open up to its previous view.  

 

To ungroup rows: 
 
1. Open up the covered columns. 
2. Highlight the row guides. 
Select Data >> Group and Outline >> Ungroup. 
The dots and bar disappears. 
 
Example:  After following directions in To group rows section, notice the each dot beside Row 

Guides 2 to 6 and the bar beside it. 
 

 
 
Clicking the “ - ” sign will result into this. 
 

 
 

Ungrouping the rows will return to its previous view. 



 

 

 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

Linking Sheets 

Formulas can be used not only for small mathematical 
operations within cells and worksheets but also to link to 
other worksheets and other workbook files. 

Writing Formulas for Multiple Worksheets 

While multiple worksheets can make working with your 

workbook more manageable, writing formulas that include 
information on different worksheets is a little complicated. 

However, when writing formulas, you can create a link 
between cells on one or more different worksheets within the 
same workbook. 

Using Special Characters 

Five symbols can be used when creating a formula that links 

two separate worksheets. Each of these symbols can be 

placed directly into the formula to complete its respective 
function.  

Character Function 

! 
Place between the worksheet name and cell 
reference 

' 
Place around the file name and sheet name or 
when a sheet name contains a  
space ('Budget 2001'!C4:C8) 

[ ] Place around a file name 

: Signifies a range (B3:C2 means B3 through C2) 

+ Signifies a range (B3+C2 means B3 and C2) 
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Creating a Link to Another Worksheet (same file) 

Excel allows you to create links to other worksheets. To do this, use the following steps: 

1. Select the cell where you want the formula to appear 
2. To create the formula, type the following:  

=function_name(worksheet_name!cell_reference) 

 
EXAMPLE: =SUM(Budget!C4:C8) 
EXAMPLE: (with space in sheet name) =SUM('Budget 2003'!C4:C8) 

3. To accept the formula, press [Enter] 
  

 

Creating a Link to More Than One Worksheet (same file) 

Excel allows you to create links to more than one worksheet at a time. To do this, use the 
following steps: 

1. Select the cell where you want the formula to appear 
2. To create the formula, type the following:  

=function_name(worksheet range!cell_reference) 
 
EXAMPLE: =SUM(Budget:Salary!D2:D10) 
EXAMPLE: (with space in sheet name) =SUM('July 2003:June 2004!'C4:C8) 

 
NOTE: Be sure to include a plus sign (+) or colon (:) between the worksheet range. 

3.  To accept the formula, press [Enter] 
 

 

Writing Formulas for Other Workbook Files 

You can create a formula to reference cells between workbook files: 

1. Select the cell where you want the formula to appear 
2. To create the formula, type the following:  

=function_name(‘[workbook_name]worksheet_name’!cell_reference) 
 
EXAMPLE: =SUM(‘[03Budget.xls]Salary’!D2:D10) 
 

NOTES:  If the two files you are working with are in different directories, you must include the 
file path in your formula. 
 
 =function_name('[file_path\workbook_name]worksheet_name'!cell_reference) 
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EXAMPLE: =SUM('[E:\Accounting\03Budget.xls]Salary'!D2:D10) 
 
NOTE: There is no difference in the formula if your sheet name contains a space. 

3. To accept the formula, press [Enter]  

 

Linking Sheets Example: 
 
1.  Create this worksheet on Sheet1 of a new workbook. 

 

 
 

The formula is cell B6 is =SUM(B2:B5), C6 is =SUM(C2:C5); and D6 is =SUM(D2:D5). 

 
2.  Click on Sheet2 in the same workbook and create this worksheet: 
 

 
 

 
3.  We're going to link cell A2 on sheet 2 to cell B6 on sheet 1. Click on in Cell A2 of    
     Sheet2, key in an =. 

 
4. Change to Sheet1.  Click on cell B6.  The marquee will appear.  Press enter.  Your  
     link should appear in cell Sheet2!A2. 
 

 
 
Test the link.  Change any of the numbers in cells B2:B5 on Sheet1.  Be sure to press the 
enter key after you key in the new number.  The total in cell Sheet1!B6 should change as well 
as the total in cell Sheet2!A2. 

 
5.  To complete the remainder of the links for Sheet2!B2 and B3, you could repeat the process  
     above.  You can also: 

6.  Click on Sheet2!A2. Select A2:C2. 
7.  Click on Edit, Fill, Right.  The remaining links should be pasted into place.   
 
Always double-check that the correct cells have been linked.  When you link between different 

workbooks, the cell references will be absolute.  Edit, Fill Right will work, and will save you a 
lot of time, but you may need to edit each linked cell to correct the cell address.  For instance, 
if our Sheet1 above was actually in a different workbook named Sales, and Sheet2 was in a 

workbook named Total Sales, when you used Edit, Fill, Right, the links would be like this: 
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Notice that all 3 cells are linked to the same B6 cell.  Edit the formulas: 

 

 
 
and the links will now work correctly. 

 



 

 

 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

Defining Page 

Setup Options 

Setting Page Margins 

The Page Margins define where on the page Excel will 
print the worksheet. By default, the top and bottom 

margins are set at 1 inch in Excel XP. The left and right 
margins are set at .75 inch. Margin settings can be 
changed to whatever you want. Different margins can be 
defined for each worksheet in the workbook. 

To Change the Margins in the Page Setup Dialog Box: 

• Select the correct worksheet.  
• Choose File Page Setup from the menu bar. 
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• Select the Margins tab. 

 

 

• Use the spin box controls to define the settings for each page margin-Top, Bottom, Left, 
Right, Header and Footer.  

• Click the OK button to change the margin settings.  

Changing the Page Orientation and Paper Size 

The Page tab of the Page Setup dialog box lets you change page orientation (portrait or 

landscape) or paper size (e.g., letter size or legal size). The default paper size in Excel XP is 
8.5 X 11 inches, with a portrait orientation (prints up and down on the long side of the page). 
A landscape orientation, on the other hand, prints up and down on the short side of the page. 

 

To Change Page Orientation: 

• Select the correct worksheet.  

• Choose File Page Setup from the menu bar.  
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• Click on the Page tab. 

 

 

• Choose an Orientation (Portrait or Landscape) for the worksheet.  
• Select a Paper Size from the list of available paper size options that appear in the list box.  

• Click on the paper size.  
• Click the OK button to accept the page settings.  

The Page tab of the Page Setup dialog box lets you shrink the spreadsheet data so it fits on 
a specified number of pages when you print. Click the Fit to: option button and enter the 
desired number of pages wide and pages tall. 

The Page tab of the Page Setup dialog box lets define the resolution of the print job. Print 
Quality is measured in dpi, or dots per inch. High dpi provides a better print quality. 

Creating Headers and Footers 

Headers and Footers can be added to any worksheet, although not required. A Header is any 

information that appear at the top of each page. A Footer prints at the bottom of the page. If 
you want a header or footer inserted onto a page then you will have to define them. Excel XP 
defaults to no header and no footer. 

To Create a Header: 

• Choose File Page Setup from the menu bar.  



Lesson 21 – Defining Page Setup Options 156156156156 

 

 
Building skills for success 

• Select the Header/Footer tab in the Page Setup dialog box. 

 

 

• Click the Header drop down list and select and of the predefined headers: 
 

 
 

OR 
 
click the Custom Header button to create your own header. Follow the instructions in the 
Header dialog box to make your entry.  
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• Click the OK button to return to the Page Setup dialog box.  

To Create a Footer: 

• Choose File Page Setup from the menu bar.  

• Select the Header/Footer tab in the Page Setup dialog box.  
• Click the Footer drop down list and select one of the predefined footers. 

 

 
 
OR 

 
Click the Custom Footer button to create your own footer. Follow the instructions in the 
Footer dialog box to make your entry.  

You can insert Placeholder buttons into both the header and footer to format text, insert 
page numbers, date, time, filename, or tab name. Excel replaces those placeholders with 

the information each represents when the worksheet is printed. Follow the instructions in 
the Header and Footer dialog boxes. 

Creating Sheet Settings 

The Sheet tab in the Page Setup dialog box provides additional print options you may want 
to add to your worksheet. 
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Print Area 

By default, Excel prints from the A1 to the last occupied cell in a worksheet. You can specify a 
different range of cells to print. 

Print Titles 

Prints column and row labels on each page of the printout. Specify these rows or columns in 
the Rows to Repeat at Top and Columns to Repeat at Left textboxes. 

Print - Gridlines 

Determines whether gridlines are printed. However, turning off gridlines does not affect their 
appearance in Normal View. 

Print - Black and White 

If you used colors in your worksheet but don't want to waste the ink in your color printer, use 
black and white. 

Print - Draft Quality 

Choose draft quality to print the worksheet without gridlines or graphics. 

Print - Row and Column Headings 

Click this option to include row numbers and columns letters in your printed document. 
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Page Order 
 

Determines the order in which worksheets are printed. 
 

Challenge 

• Create a spreadsheet with whatever information you want to include on it.  

• Set the Print Margins to print 0.5" from the Top, 0.5" from the Bottom, 0.5" from the Left 
and 0.5" from the Right.  

• Change the Print Orientation to portrait.  

• Change the Paper Size to Legal.  
• Create a Header that shows a page number.  
• Create a Custom Footer that shows the date in the Center Section.  
• Set Print Gridlines for the sheet to "yes."  

 



 

 

 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

Print Management 

Specifying a Print Area 

In Excel XP you can print an entire workbook, a 
worksheet, a cell range or a cell. Excel defaults to 

printing the entire worksheet. But if you want to print 
only a certain area of a spreadsheet then you can define 
a print area. 

To Specify a Print Area: 

• Choose View Page Break Preview from the 
menu bar. 
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• A reduced image of the chart is displayed on the screen.  

• Click on one of four blue-colored borders and drag to highlight and select the area to print. 
 

 

• Choose File Print Area Set Print Area on the menu bar. 
 

 

Only that area you defined in the print range will print when the worksheet is submitted to the 
printer for printing. 

Previewing a Page Before Printing 

Excel XP provides a Print Preview capability that shows a smaller picture of the printed page 

directly on the computer screen. Print Preview is a good way for you to review the formatting 
and make sure the columns, rows and margins appear exactly where you want them. 

To Print Preview: 

• Choose File Print Preview on the menu bar, or 

 
Click the Print Preview button on the standard toolbar. 
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• In Print Preview window, the document is sized so the entire page is visible on the 

screen. Simply check the spreadsheet for overall formatting and layout. 
 

 

The Zoom button in Print Preview will enlarge the data so it can be read.  

Inserting and Removing a Page Break 

There are two different kinds of page breaks in Excel: soft page breaks and hard page breaks. 

A soft page break is automatically inserted into a spreadsheet when there is too much data to 
fit on one page. A hard page break is one that you can insert into a spreadhseet, wherever you 
want it to appear. 

To Insert a Page Break: 

• Move the cursor to the row where a page break needs to be inserted. This row will be the 

first row on the new page.  
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• Choose Insert Page Break from the menu bar. 
 

 

• A page break, indicated by a dashed line, is inserted into the worksheet.  

To Delete a Page Break: 

• Move the cursor to the row where a page break appears  

• Choose Insert Remove Page Break from the menu bar. 

 

 

• The page break (represented by a dashed line) is removed from the page.  

Printing a Worksheet or Workbook 

Printing in Excel is much like printing in other Office applications like Microsoft Word. As 
previously mentioned, Excel defaults to printing the entire worksheet. 

To Print a Worksheet: 



Lesson 22 – Print Management 164164164164 

 

 
Building skills for success 

• Choose File Print from the menu bar. 

 

 

• The Print dialog box opens. 

 

 

• Specify the Printer Name where the spreadsheet will print. If you only have one printer in 
your home or office, Excel will default to that printer.  

• In Print Range, choose whether to print All or a certain range of pages (Pages From n 

to y, where n and y are the beginning and ending page numbers.  
• In Print what, choose whether to print a Selection, the Active sheet or the Entire 

Workbook (all worksheets in the workbook). Excel defaults to the Active Sheet.  

• Choose the Number of Copies to print by clicking on the up or down arrows.  
• Click the OK button to print the worksheet.  

Don't print your Excel spreadsheet without checking spelling first! Excel includes two tools 
to help correct spelling errors: AutoCorrect and Spelling. 

Challenge 

• Type the following information on the worksheet:  
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In cell A2, type January 
In cell A3, type February 

In cell A4, type March 
In cell B1, type Bill 
In cell B2, type 3542 
In cell B3, type 7184 

In cell B4, type 6531 
In cell C1, type Mary 
In cell C2, type 2943 

In cell C3, type 6542 
In cell C4, type 7137 
In cell D1, type Bob 
In cell D2, type 3403 

In cell D3, type 7314 
In cell D4, type 6942 

• Create an embedded Area Chart as discussed in Lesson 16.  
• Define a Print Range that includes only the Area Chart and not the Source Data.  
• Use Print Preview to preview the chart prior to printing.  

• Reset the Print Range to include both the Source Data and the Area Chart.  
• Insert a Page Break between the Source Data and the embedded Area Chart.  
• Send two copies of the two-page worksheet to print at the default Printer Name.  



 

 

 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

Working with 

Excel’s List 

Features 

Excel has features that let you create and sort lists of related 
information; in essence, this means that you can use Excel 
as a database program. In this chapter, we will show you 
how to create a list and then how to sort and filter the 

information to display only the details you want to see.  

 

Creating Lists  

It is very easy to create a list that you can use as a database 

in Excel. All you have to do is type the list data into your 
worksheet. When you do this, keep the following points in 
mind:  

• Some of Excel's database capabilities can be used on only 
one list at a time, so you should create each list on a 
different worksheet.  

• Excel uses blank rows to detect lists, so you should have at 
least one blank row between your list and any other 
worksheet data. Also, you should not put any blank rows or 
columns within the list.  

• The first row of your list should contain column labels that 

are formatted differently to the list data; these labels 
become the field names in your database and Excel uses 
them to find and sort the information in the list. You must 
not use a blank row to separate the column labels from the 
first row of data in the list.  

• When you enter your list data, make sure that the rows 
contain similar items in each column. Also, do not put spaces 
at the beginning of cells-this affects some of the database 
capabilities.  
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Figure 1. Here is a list that we have created. Notice that the formatting of the column labels 
differs from the formatting of the list data. 

 
 

 
Sorting and Filtering Lists  

The most useful databases, or lists, are those that let you sort and extract information so that 
it can be used for a number of different purposes. For example, the list in the previous figure 

contains records of a company's purchases. Each record contains a description of what was 
bought, the department that bought it, the name of the person who bought it, how much it 
cost, and which project it was for. The list is for January, and the records are organized in 

order according to the date. Different people in the company would need to access this 
information differently.  

If you were a department manager, you might want to sort the records so that each 
department's purchases were listed together and you could see how much your department 
had spent over the month. If you were a project manager, you might want to sort the list 

according to project numbers so that you could see how much each project cost in January. 
Excel's sorting and filtering capabilities let you do this. You can sort lists to display the 
information in a different order, and you can filter lists to display some information and hide 
the rest.  

Sorting Lists  

Figure 2. Sometimes you may need to perform a simple sort, such as sorting a list based on 

the contents of one column. To do this, you click on a cell in the column you want to sort, then 
click on either the Sort Ascending or Sort Descending button on the Standard toolbar. The Sort 
Ascending button sorts the list in ascending order (A-Z, 1-9) and the Sort Descending button 
sorts the list in descending order (Z-A, 9-1).  
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In this example, we want to sort the list alphabetically, based on the contents of the 
Department column, so that we can group the purchases for each department. To do this, we 
must click on a cell in the Department column, then click on the Sort Ascending button. 

 

Figure 3. After you click on the Sort Ascending or Sort Descending button, Excel detects and 
selects the list, then rearranges the list based on the column you specified. In this example, 

Excel has sorted the Department column in ascending alphabetical order. We can now see all 
the purchases for each department grouped together.  
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Figure 4. Sometimes you will want to sort your list based on the contents of more than one 

column. Here you can see our sample list. Let's look at how to sort it based on the Department 
column, then the Name column, then the Total Cost column. This way we will be able to see 
what each department is spending, and who is spending the most in each department. 

 

Figure 5. To sort a list based on more than one column, click on a cell in the list that you want 
to sort, then from the Data menu select the Sort command. 
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Figure 6. Excel then opens the Sort dialog box. In the Sort by section, select the first column 

you want to sort by, then click on either the Ascending or Descending radio button to specify 
the sort order you want to use. In this example, we are sorting in ascending order based on 
the Department column, then in ascending order based on the Name column, then in 
descending order based on the Total Cost column.  

The My list has section lets you tell Excel whether or not your list has column labels, called a 
header row.  

When you have made your choices, click on the OK button to sort the list. 

 

Figure 7. Excel has sorted the list according to the columns we specified in the Sort dialog 

box. We can now see the information we wanted, but there is still a lot of superfluous 
information on the screen. We can go one step further and filter the list to display only the 
information we want to see. 



Lesson 23 – Working with Excel’s List Features 171171171171 

 

 
Building skills for success 

 

Filtering Lists  

Figure 8. The easiest way to filter a list is to select a cell in the list, then open the Data menu 
and select the Filter command, then choose the AutoFilter command. 

 

Figure 9. Excel then adds AutoFilter arrows to each column in the list. You use these arrows to 
filter out the information you don't need.  

Here is our sample list again; you may have noticed that we have hidden columns D, E, and F 
so that you can see the relevant figures more easily.  
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Figure 10. Click on the AutoFilter arrow of the first column you want to filter. In this example, 

we want to see only the sales department's purchases, so we select the Sales option from the 
list. 

 
 

Figure 11. You can see that Excel has filtered the Department column and now displays only 
those records for the sales department. 
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Figure 12. Now click on the AutoFilter arrow of the next column you want to filter. In our 

example, we want to see only those records for the name "Orlovic, P.", so we select this option 
from the list. 

 

Figure 13. Excel has filtered out all names except "Orlovic, P.".  

 

Figure 14. Finally, we want the Total Cost column to show only those records which are 
greater than $200. To do this, we click on the AutoFilter arrow and choose the Custom option 
from the list. 

 

Figure 15. Excel then opens the Custom AutoFilter dialog box where you can specify how 

you want to filter the column. From the first box we selected the is greater than option, and in 

the second box we typed 200 because we want to show only those records that are greater 
than $200. After you select the options you want, click on the OK button. 
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Figure 16. Excel has again filtered the information. We can now see that P. Orlovic from the 
sales department has made two purchases over $200. 

 
 

Removing filters  

Figure 17. To remove a filter from a column, click on the AutoFilter arrow and select the All 
option. 

 

Figure 18. To remove filters from all columns in a list, but leave the AutoFilter arrows, open 

the Data menu and select the Filter command, then from the submenu select the Show All 
command.  

  

Figure 19. To remove the AutoFilter arrows from the columns in a list, open the Data menu 
and select the Filter command, then from the submenu select the AutoFilter command. 
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Using Data Forms with Lists  

Long, detailed lists are often difficult to navigate because of their size. It can be very 
frustrating to scroll across many columns just to see all of the information in a single record. 

To overcome this difficulty, you can use data forms. A data form looks like a dialog box, but it 
contains the column labels from your list rather than dialog box options. You can use data 
forms to view the records in a list one at a time. You can also use data forms to add records to 
and delete them from a list.  

Viewing Records in a list  

Figure 20. To view records using a data form, click on a cell in the list, then from the Data 
menu select the Form command. 

 

Figure 21. Excel then opens a data form. You can see the first record in the current list. To 

view the next record in the list, click on the Find Next button, and to view the previous record 
in the list, click on the Find Prev button.  

You can use the data form to search for records that match criteria you specify. To do this, 
click on the Criteria button. 
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Figure 22. After you click on the Criteria button, Excel clears the data form so that you can 
specify the criteria you want the records to match. Notice that the word Criteria appears in the 

top-right corner of the dialog box, and the Criteria button has become the Form button. You 
can leave the criteria search by clicking on the Form button.  

In this example, we are searching for records whose total cost is greater than $1000. To find 
records that match this criterion, we must type >1000 into the appropriate text box and click 
on the Find Next button.  

  

Figure 23. Excel then displays the first record whose total cost is greater than $1000. At the 
top-right of the dialog box, we can see that this is record number 10 of 27 records. To view the 
next record that matches the criterion, we can click on the Find Next button again.  

To close the data form, click on the Close button. 
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Adding Records to a List  

Figure 24. You can add records to a list by typing them in on the worksheet, but it is often 
easier to use a data form.  

To add a new record to your list using a data form, click on a cell in the list, then open the 
Data menu and select the Form command. 

 

Figure 25. Excel opens the data form. You can see the first record in the list. To add a new 
record, click on the New button. 

  

Figure 26. After you click on the New button, Excel opens a new form so that you can type in 

the information for the new record. To move from one field to the next, press the Tab key, or 
use the mouse to click in the field.  

When a column in the list contains a formula, you cannot type information on the form for the 
corresponding field because its contents will depend on other field values. In this example, the 
Total Cost column in our list contains a formula, so we can't type information in the Total Cost 

field on the form. The value in this field is calculated automatically after we type in the values 
for the Unit Cost and Quantity fields, which are the arguments of the formula.  
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Figure 27. After you have typed the new record, you can add it to the list by pressing the 
Enter key. Excel then opens a blank form, ready for you to type another record.  

To add the new record to the list and close the data form at the same time, click on the Close 
button. 

 
   

Deleting Records from a List  

Figure 28. You can remove records from a list by deleting them on the worksheet, but it is 
often easier to use a data form.  

To delete a record from your list using a data form, click on a cell in the list, then open the 
Data menu and select the Form command. 
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Figure 29. Excel opens the data form. You can see the first record in the list. Use the Find 
Next and Find Prev buttons to display the record you want to delete, then click on the Delete 
button. When you delete a record using a data form, the deletion is permanent and it cannot 
be undone.  

 
 

Adding Subtotals to Lists  

Sometimes you may want to summarize data in a list by showing subtotals for particular fields. 
You can do this using the Subtotals command on the Data menu.  

Figure 30. Before you can add subtotals to a list, you must sort the list based on the column 

for which you want the subtotals. In this example, we want subtotals for each department. To 
do this, we click on a cell in the Department column, then click on the Sort Ascending button to 
sort the departments in ascending alphabetical order. (For more information about sorting a 
list, see Sorting Lists earlier in this chapter.) 
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Figure 31. After you have sorted your list, you can add subtotals to it. To do this, click on a 
cell in the list, then from the Data menu select the Subtotals command. 

 

Figure 32. Excel then opens the Subtotal dialog box. In our example, we want to add the 
subtotals for each department, so from the At each change in list box, we selected the 
Department option.  

We want to add the values to produce subtotals, so from the Use function list box, we selected 
the Sum option.  

We want to include the subtotals at the bottom of the Total Cost column, so from the Add 
subtotal to section we selected the Total Cost check box.  

The check boxes at the bottom of the dialog box let you choose further options for the 
subtotals. When you have selected the options you want, click on the OK button. 
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Figure 33. Excel then adds the subtotals and an outline to your worksheet. 

To remove subtotals from a list, click on the Remove All button in the Subtotal dialog box (see 
Figure 32). 

 
 
 
 
 

 
 
 

 
 
 



 

 

 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 
 
 

 
 
 
 

 
 

More Functions 

Excel Logic Functions 

Excel logic functions give Excel the ability to think...Sort 
of. 

Logic functions are used when a decision has to be made, 
usually when we are comparing our data against several 
different possibilities. 

IF Function - Returns one value if a condition you specify is 

TRUE and another if it isn't. (see Using the IF Function in 
Lesson 10 - Functions) 

AND Function - Tests multiple arguments and returns TRUE 
if ALL these arguments are TRUE and FALSE if ANY of them 
are not true. 

OR Function - Tests multiple arguments and returns TRUE 
if ANY of the arguments are TRUE. 

NOT Function - Reverses the logic of its argument: returns 

FALSE for a TRUE argument and TRUE for a FALSE 
argument. 
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Excel AND Function 

This Excel function returns a logical value, either TRUE or FALSE depending on the logical value 
of each of its arguments. 

The AND function can contain up to 30 separate arguments and if ALL of those arguments 
are TRUE, the AND function returns TRUE, but if ANY of those arguments are FALSE, the AND 

function returns  
FALSE. 

The syntax (the order and sequence) for the AND function is  

=AND(logical1,logical2...) 

where: 
 
logical1 through to logical30 are conditions you want to test that can be either TRUE or 

FALSE and can be logical values, arrays or references. 

Plain English Zone 

In plain English the Excel AND function syntax can be read as: 

AND(this is TRUE, so is this, and this as well) returns TRUE 

AND(this is TRUE, so is this, this is not) returns FALSE 

 
AND Function Example 

Usually you will find that you will use the AND function in conjunction with the Excel IF 
function, or as part of another Excel formula.  

That is exactly what we’re going to do here. 

This is a small class of very bright pupils and they have undertaken exams in Maths, Physics 
and Chemistry. 

In order to be a Science Prize Winner they had to score greater than 75% for Maths, greater 
than 75% for Physics and, because it was felt that the Chemistry exam was a little too easy 
this year, they were required to score in excess of 80%. 
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As you can see in the example above, we have placed our AND function in cell F3, then 
subsequently copied it down through to cell F9. 

What we want to do is discover if any of the pupils have scored consistently high enough to be 
a prizewinner. 

In cell F3 IF ALL of our AND conditions are TRUE we want to return the text string "Yes", but 
if ANY of our AND conditions are FALSE we want to return the text string "No." 

Using our syntax let's work through the formula.  

The logical_test asks is the value held in cell C3 greater than75% 

AND 

is the value held in cell D3 greater than75% 

AND 

is the value held in cell E3 greater than80% 

value_if_true says "All those conditions are true! Enter "Yes" in the cell." 

value_if_false says "One or more of those conditions are FALSE. Enter "No" in the cell" 

 

Excel OR Function 

The Excel OR function is similar in operation to the Excel AND function and returns a 
logical value, either TRUE or FALSE depending on the logical value of each of its arguments. 

The OR function can contain up to 30 separate arguments and if ANY of those arguments are 
TRUE, the OR function returns TRUE, but if ALL of those arguments are FALSE, the OR 
function returns FALSE. 

 

The syntax (the order and sequence) for the OR function is  
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=OR(logical1,logical2...) 

where: 
 

logical1 through to logical30 are conditions you want to test that can be either TRUE or 
FALSE and can be logical values, arrays or references. 

Excel OR Function Example 

As with the Excel AND function you will normally find that you will use the OR function in 
conjunction with the IF function, or as part of another Excel formula.  

Let's take our group of school children again. 

This is a small class of very bright pupils and they have undertaken exams in Maths, Physics 
and Chemistry. 

This time we want to reward our pupils with a certificate of excellence if they have managed to 
achieve a pass mark of greater than 85% in any of their three exams. 

 

 As you can see in the example above, we have placed our OR function in cell F3, then 
subsequently copied it down through to cell F9. 

What we want to do is discover if any of the pupils have scored over 85% in any of their 
exams. If they have we want to place a "Yes" text string in the cell, and if they haven't we 
want to place a "No" text string in the cell. 

Using our syntax let's work through the formula.  

The logical_test asks is the value held in cell C3 greater than 85% 

OR 

is the value held in cell D3 greater than85% 

OR 

is the value held in cell E3 greater than85% 

value_if_true says "One or more of those conditions are true! Enter "Yes" in the cell." 
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value_if_false says "All of those conditions are FALSE. Enter "No" in the cell" 

 
 

Excel NOT Function 
 
 

In Excel, the Not function returns the reversed logical value. 

The syntax for the Not function is: 

Not( logical_value ) 

logical_value is an expression that either evaluates to TRUE or FALSE.  If the Not function is 
used with an expression of TRUE, then FALSE is returned.  If the Not function is used with an 
expression of FALSE, then TRUE is returned. 

 

For example:  

Let's take a look at an example:  

 

Based on the Excel spreadsheet above:  

=Not(TRUE) would return FALSE. 

=Not(FALSE) would return TRUE. 

=Not(A1<10) would return FALSE. 

=Not(A2="Microsoft") would return TRUE. 

=Not(A2="techonthenet") would return FALSE. 

=Not(5+1=7) would return TRUE. 
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Excel Math Functions 
   

Aside from the usual functions that are discussed in Lesson 10, Excel offers lots of Math 
functions. Here are some of the Math functions.  

Count cells that match criteria – COUNTIF Function 

Match criterion exactly – COUNTIF Function 

You can count cells that meet a specific criterion. In this example only the Pen orders will be 
counted. 

1. Select the cell in which you want to see the count (cell A12 in this example)  

2. Type an equal sign (=) to start the formula  
3. Type:   COUNTIF(  
4. Select the cells that contain the values to check for the criterion. In this example, cells 

A1:A10 will be checked  
5. Type a comma, to separate the arguments  
6. Type the criterion. In this example, you're checking for text, so type the word in double 

quotes:   "Pen" 

Note: upper and lower case are treated equally 
7. Type a closing bracket 

The completed formula is: =COUNTIF(A1:A10,"Pen") 

8. Press the Enter key to complete the entry  
9. The result will be 4, the number of cells that contain "Pen" 

 

Match criterion in a string – COUNTIF Function 

You can count cells that contain a criterion as part of the cell's contents. In this example all 
Pen, Gel Pen, and Pencil orders will be counted, because they contain the string "pen". 

1. Select the cell in which you want to see the count (cell A12 in this example)  

2. Type an equal sign (=) to start the formula  
3. Type:   COUNTIF(  
4. Select the cells that contain the values to check for the criterion. In this example, cells 

A1:A10 will be checked  
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5. Type a comma, to separate the arguments  
6. Type the criterion. In this example, you're checking for text, so type the word in double 

quotes, with one or more asterisk (*) wildcard characters:   "*Pen*" 
Note: upper and lower case are treated equally 

7. Type a closing bracket 
The completed formula is: =COUNTIF(A1:A10,"*Pen*") 

8. Press the Enter key to complete the entry  
9. The result will be 6, the number of cells that contain the string, "Pen" 

Note: Instead of typing the criterion in a formula, you can refer to a cell. For example, the 
formula in step 7 above could be changed to:  =COUNTIF(A1:A10,"*" & B12 & "*") if cell 
B12 contained the text — pen. 

     

Criterion and operator – COUNTIF Function 

You can use an operator with a criterion. In this example only the rows where the quantity is 
greater than or equal to ten will be counted. 

1. Select the cell in which you want to see the count (cell A12 in this example)  
2. Type an equal sign (=) to start the formula  

3. Type:   COUNTIF(  
4. Select the cells that contain the values to check for the criterion. In this example, cells 

B1:B10 will be checked  
5. Type a comma, to separate the arguments  

6. Type the criterion. In this example, you're checking for rows where the quantity is greater 
than or equal to 10. The >= operator is used before the number, and the entire criterion is 
enclosed in double quotes: ">=10" 
Note: Even though this is a numerical criterion, it must enclosed in double quote marks.  

7. Type a closing bracket  
 
8. The completed formula is:  

        =COUNTIF(B1:B10,">=10") 
 
9. Press the Enter key to complete the entry  
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Note: Instead of typing the criterion in a formula, you can refer to a cell. For example, the 
formula in step 8 above could be changed to:  =COUNTIF(B1:B10,">=" & B12) if cell B12 
contained the number — 10.  

Or, you could use a function as part of the criterion.  

For example:  =COUNTIF(A1:A10,"<"&TODAY())  

 
 

Match criteria in a range – COUNTIF Function 

You can combine COUNTIF formulas, to count rows that are within a range of values. In this 
example, the formula will count rows where the quantity is between 5 and 10 (inclusive). 

1. Select the cell in which you want to see the count (cell A12 in this example)  
2. Type a formula to count rows greater than or equal to 5:  
          =COUNTIF(B1:B10,">=5") 

3. Type a minus sign  
4. Type a formula to count rows greater than 10:  
          COUNTIF(B1:B10,">10") 
5. The completed formula is: 

=COUNTIF(B1:B10,">=5")-COUNTIF(B1:B10,">10") 
6. Press the Enter key to complete the entry  

Note: Instead of typing the criterion in a formula, you can refer to a cell. For example, the 
formula in step 8 above could be changed to: =COUNTIF(B1:B10,">=" & B12) -  
COUNTIF(B1:B10,">" & C12) if cell B12 contained the number — 5 and cell C12 contained 
the number — 10. 

 

Excel SUMIF Function 

The Excel SUMIF function is an extension of the standard Excel SUM function. 
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What the Excel SUMIF function allows you to do is SUM data only if it meets certain criteria 
that you have specified. 

Let's say that you had a very small clothing store with only four departments, Sportswear, 
Evening Wear, Swimwear and Children's clothes.  

You have been provided with a list of sales, by department and month, for the first quarter of 

the year, and what you would like to do is add up the sales for the quarter for the department 
that you specify. 

The syntax, or structure, for the SUMIF function is as follows: 

SUMIF(Range,Criteria,Sum_range)  

Where...   

Range = the range of cells that you are evaluating for specific criteria 

Criteria = the criteria you are looking for, and   

Sum_Range = the range of cells that are to be summed if the criteria is met.  

  

Now, when you are using this function this is what you are telling Excel to do.  

1. Look in the range of cells that we did.  
2. If any of the cells that we’ve match the criteria that we specified...then  
3. Add up the corresponding cells in the second range and return the result.  

Let's have a look at the example. 

 

You can see from the formula in the above example that we have looked for any instances of 
the word "Swimwear" in the range B1:B13.  
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Where this has occurred we have summed the sales figures from the range C1:C13, giving a 
total sales figure for the Swimwear department of 112,803 for the quarter.  

 

Excel SUMPRODUCT Function 

Once you've been introduced to the Excel SUMPRODUCT Function you'll never look back. 

This a little known but power packed Excel function. 

As implied by its name the SUMPRODUCT function combines two of Excel's other, better 
known, functions, SUM and PRODUCT. 

Rather than waffle on too much let us dive straight into an example: 

 

As you can see from the illustration above we have two columns Cost Per Unit and No. of 
Units Sold. What we would like to know is the total cost of ALL the units sold. 

Normally to achieve this we would insert an extra column, let's call it Total Cost and insert the 
product function in the first cell and copy it down to the remaining cells. 

 
  

After doing that we would then SUM this third column to obtain the answer we were looking 
for.  
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Instead of doing that we are going to use SUMPRODUCT to provide us with the same answer 
in a fraction of the time it took to perform the previous actions. 

The SUMPRODUCT syntax is as follows:  

=SUMPRODUCT(Array1,Array2,Array3...,) up to a maximum of 30 Array dimensions. 

In our example we only have two arrays, which are the cell ranges A2:A6 and B2:B6 under 
the respective columns headed Cost Per Unit and No. Of Units Sold. 

In cell B8 type =SUMPRODUCT(A2:A6,B2:B6)  

 

The SUMPRODUCT function returns the same answer that we arrived at earlier. 

If that was the only ability it had, it would still be pretty useful, however this function has 
some other, much more productive capabilities. 

The SUMPRODUCT function also has the ability to: 

1. Act like the SUMIF function's elder brother on steroids.  
2. Be used in a formula to instantly calculate weighted averages.  

To find out how to perform SUMIF like functions with multiple criteria then read on: 

Shown below is our criteria. As usual we will use a simple example. 
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We have three criteria to match in this example, Region, Country and Division. 

When all three criteria are matched we want to bring back the number of units. 

The easiest way to do this is to copy the headings and place them below the data. Obviously, 
in this example, this is easy to do because there aren't many lines of data. If, however, you 
have thousands of lines of data then just place your headings in a convenient place. 

 

  

This is where the magic occurs: 

In cell D13 type 

=SUMPRODUCT((A2:A9=$A$13)*(B2:B9=$B$13)*(C2:C9=$C$13)*(D2:D9)) 

What we are saying in this formula is  

Find the rows where all of the following are correct; 

South is in the cell range A2:A9, 

US is in the cell range B2:B9, and  

Sales is in the range C2:C9  
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and then SUM the units. 

In this case our criteria was matched in rows 7 and 9 and the total number of units was 14. 

Once you have set your spreadsheet up like this, you just adjust the criteria in cells A13,B13, 
and C13 accordingly. 

 

 

 

 

Excel ROUND Function 

Rounding numbers or the results of calculations in Excel is simple when you use the ROUND 
function. 

Let's say we had numbers in cells A1 and B1 and we wish to multiply them together and put 
the result, rounded to 2 decimal places, into cell C1. 

The structure of the Excel ROUND function is: 

=ROUND(number,num_digits) 

where number is the number or result of a calculation or reference to a cell where the result is 
held  

and num_digits is the number of digits to which you wish to round 

In our example we would write the formula as: 

=ROUND(A1*B1,2) 

 

On occasions you might want to force your result to either round up or round down rather than 
allow Excel to dictate which way the result should be rounded. 

In those instances you can use either the ROUNDUP or the ROUNDDOWN function. The syntax 
or structure of these functions is exactly the same as for the ROUND function. 

Taking the same numbers as above, if we used the ROUNDDOWN function and rounded to two 
decimal places again we would have the result of 47.74 returned. 

How to quickly round to the nearest 10 

Very often Excel users have the need to round to the nearest 10, 100 or 1000 etc. 

Use the Excel ROUND function and use a negative number for the num_digits argument. 
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Using the same numbers as in the previous examples, we decide to round to the nearest 10, 
so we are going to use -1 as my num_digits argument.  

 

If we wanted to round to the nearest 100 we would use -2.  

  

Rounding to numbers other than multiples of 10 

To round to numbers other than multiples of 10 using Excel's ROUND function is also 
reasonably straightforward. 

Again we will use the same numbers as above but this time we will round to the nearest 6. 

We know that the result of the initial calculation was 47.749782, so rounding this to the 
nearest multiple of 6 will give us the answer 48. 

This is how we do it. 

=ROUND((A1*B1)/6,0)*6 

Strictly speaking it is not necessary to have A1*B1 in parentheses due to the order of 

calculations in Excel, but we like to add them just for neatness. The screenshot below shows 
the formula without the parentheses. 

 

  

Rounding Up or Down to multiples other than 10 

It is possible to use the above formula in conjunction with either ROUNDUP or ROUNDDOWN, 
but the formulas start to get unnecessarily messy, especially when there is no need to do it. 

Excel has provided two functions that do just that and they are the Excel CEILING function and 
the Excel FLOOR function. 

 

Excel CEILING Function 

Excel provides the CEILING function which returns a number rounded up based on a multiple 
of significance. 

We am going to use the same numbers that we used in the ROUND function examples. 
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The syntax or structure of the CEILING function is: 

=CEILING(number,significance) 

where number is the number or result of a calculation or reference to a cell where the result is 
held  

and significance is the multiple of significance to which you wish to round up. 

In this case we want to round up to the nearest multiple of 6, so my formula is  

=CEILING(A1*B1,6) 

which gives us the result of 48. 

 

 

Excel FLOOR Function 

Excel provides the FLOOR function which returns a number rounded down based on a 
multiple of significance. 

We are going to use the same numbers that we used in the ROUND function examples. 

The syntax or structure of the FLOOR function is: 

=FLOOR(number,significance) 

where number is the number or result of a calculation or reference to a cell where the result is 
held  

and significance is the multiple of significance to which you wish to round down. 

In this case we want to round down to the nearest multiple of 6, so my formula is  

=FLOOR(A1*B1,6) 

which gives us the result of 42. 
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Excel Lookup Functions 

Excel lookup functions are mainly used when are dealing with lists of data, or when you 
need to return a value.  

Out of the seventeen functions that are categorized as Lookup and Reference we are 
featuring just a handful here. 

VLOOKUP Function - the VLOOKUP function works in the same manner that you would use to 
find someone's number in the phone book. 

It searches down the leftmost column of the data range you are searching, then reads across, 
bringing back the data from the column you specified. 

HLOOKUP Function - Works exactly the same way as the VLOOKUP function but turned 90 
degrees. This time we search across the top row, then read downwards. 

INDEX Function - at first site seems completely useless, but when combined with MATCH or 
other functions you get awesome results. 

The index function returns the value from a range when you specify the column and row 
number.  

MATCH Function - Returns the position within a range of cells where your specified value is 
held. This can be either a row or a column of data. 

OFFSET Function - Returns a reference to a range that is a specified number of rows and 
columns from an initial starting point. 

 

Excel VLOOKUP Function 

The VLOOKUP function is likely to become very familiar to you if you use Excel for any length 
of time.  

Along with SUM and SUMIF, VLOOKUP is one of the most used Excel functions. 

The VLOOKUP function works by searching down the leftmost column of your data and then 
reads across the row to find the value in the column you specify.  

If you think of the process as similar to that which you would adopt when searching for a 
phone number in a directory, you won't go far wrong. 

In fact, let's use the phone directory scenario to illustrate the Excel VLOOKUP function in 
action. 

Below is a list of names and their corresponding phone numbers. We would like to be able to 
type in a name and have the phone number automatically returned. 
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For this particular example we am going to use two cells, one for inputting the name of the 

person who's number we want, and the second cell will be where we enter the VLOOKUP 
function which will return the phone number. 

  

1. Click in cell B12 and type "David Beckham". (without the quotes)  
2. Click in cell C12 and type "=VLOOKUP"  
3. On the formula bar click on the = sign.  

 

 As soon as you have clicked on the "=" sign the following dialog box appears.  
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If the dialog box has covered the data just left click near the top of the box and drag it out of 
the way so you can once again see the data.  

The cursor will be flashing in the Lookup_value box. 

4. Now, because we are going to use cell B12 as the data entry box for the name of the 
person who's number we are looking up we will enter B12. This can be typed in or 
alternatively you can use your mouse and click on cell B12.  

  

5. Click in the Table_array box and then select the range of cells from A1 to B10.  
6. Click in the Col_index_num box and type the number 2.  
7. Click in the Range_lookup box and type in "False". In this example we wish to find an 

exact match for the value we specified in the Lookup_value box. Had we been looking for 

the closest match then we could have used "True" instead.  
8. Click on the "OK" button.  
9. The phone number 555-133-614 is returned. We can verify that this is correct by looking in 

cell B7.  

  

Plain English Zone 

In plain English this is what the Excel VLOOKUP function says:  

Look down the Leftmost column within the data we have specified until you find the name 
"David Beckham". 

Now you've located "David Beckham", move along the row until you get to the second column 
and return the value that is in that cell.  

 
Excel HLOOKUP Function 
 

The HLOOKUP function works exactly the same way as the VLOOKUP function but turned 
clockwise 90 degrees. 

HLOOKUP reads across the first or uppermost row of data searching for the column that 
contains the value you have specified. 

When it finds the specified value it then moves down the rows and returns the value from the 
row number that you specified. 

Let's look at an example of the Excel HLOOKUP function as this will make it clearer. 
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In this simple table we have the field names in the first four rows and each record is kept in a 
single column. 

We would like to type in a client's name and have returned that client's occupation. 

The syntax for the HLOOKUP function is 

=HLOOKUP(Lookup_value,Table_array,Row_index_num,Range_lookup) 

where 

Lookup_value is the value you are looking for in the first row of your array 

Table_array is the range of cells you are searching 

Row_index_num is the rows number from which the value should be returned 

Range_lookup is an optional argument. Use FALSE to ensure you find an exact match or TRUE 
to find the nearest value. If omitted then TRUE is the default value) 

In cells A7 and B7 we are going to enter the headings Name and Occupation. 

Cell A8 is where we will type in our clients name. 

In cell B8 we enter the formula =HLOOKUP(A8,$A$1:$D$4,3,FALSE) 

 

  

We typed "Matthew" in cell A8 and so we have the value "Student" returned. 

The Excel HLOOKUP function in this example has taken the value from cell A8, looked for it in 
the top row of the range of cells $A$1:$D$4 then, when it has found it, has gone down to the 
third row in our range of cells and returned to us the value that is in that cell. 



Lesson 24 – More Functions 201201201201 

 

 
Building skills for success 

 

 

INDEX Function 

The Excel Index function is used in a similar way to how you would use a grid reference on a 
map. 

Given the row number and the column number you know exactly which cell you are looking at 
or referencing. The grid structure of Excel naturally makes the Index function quite intuitive. 

The syntax of the Excel Index function can take two forms. These are either: 

=INDEX(Array,Row_num,Column_num) 

where 

Array is the range of cells that you are working with 

Row_num indicates the row you wish to use in your reference, and 

Column_num indicates the column you wish to use in your reference 

or 

=INDEX(Reference,Row_num,Column_num,Area_num) 

where 

Reference is a reference to one or more cell ranges, 

Row_num indicates the row you wish to use in your reference, 

Column_num indicates the column you wish to use in your reference, and 

Area_num indicates which area within Reference that you wish to use 

 

To clear up any confusion, use the first form of the formula if the range of cells you are 
working with are contained within one single block, and use the second form when the cells 
you are working with are split into several individual blocks. 

We are going to use the first form of the Index function in our example. 

In our example below we have named the range of cells B2:F11 "IndexData". 
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In cells C14 and C15 we have placed the references for the row and column numbers 
respectively. 

Cell C16 contains the formula =INDEX(IndexData,$C$14,$C$15) wish is effectively saying, 

"Within the array named IndexData, bring back the cell contents that are situated at the 
intersection of row 5 and column 4" 

In this case the resulting value is 139 which we have highlighted within the array. 

 
 
Excel MATCH Function 

Excel MATCH is a simple little function that returns the relative position of the cell within an 
array rather than returning the actual value contained within the cell. 

The syntax or structure for the Excel MATCH function is: 

=MATCH(Lookup_value,Lookup_array,Match_type) 

where 

Lookup_value is the value you are looking up and wish to match within the array, 

Lookup_array is the range of cells in which you are looking for the match, and 

Match-type is either -1, 0, or 1 

-1 will find the smallest value that is equal to or greater than the lookup value. The array must 
have been sorted in descending order 

0 will find the exact match. The array does not need to be sorted in any order. 
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1 will find the largest value that is equal to or less than the lookup value. The array must have 
been sorted in ascending order. 

  

In the example below we have the months January through to May in an array which we have 
named "Months". 

 

We want to find out where "April" is positioned within the "Months" array so we enter "April as 
the lookup value. 

 

After entering our lookup value we type in the formula: 

=MATCH(C4,Months,0) 

We have used the Match type 0 because we wanted an exact match, and the value returned to 
us is 4. 

This represents that April is the fourth value along in the array. 

Knowing the position of a particular cell comes in useful when you combine it with other Excel 
functions. 

For example you can combine the MATCH function with the INDEX function to perform lookups 
without having the limitations that are present when using VLOOKUP. 

 
 
 

Excel OFFSET Function 

We use Excel's OFFSET function to return a reference to a cell or range of cells that is a specific 
number of columns and rows from a specific starting point. 

Imagine you have an old crinkled up piece of parchment...a Pirate map, complete with 
instructions on how to find the buried treasure. 

As with all good pirate maps you always start "on the spot marked with an X." 

The instructions tell you to take three steps forward and one step sideways, to the right. 

Now start digging, you scurvy landlubbers! 
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This is exactly how Excel's Offset function works. You start at a particular cell, then move a 
specific number of rows up or down, then move a specific number of columns left or right. 

You will notice in the formula from the example above that the number of rows is a negative 4. 
This is because, although it appears to us that we are moving upwards, as far as Excel is 
concerned, we are moving from row 12 to row 8, i.e. backwards. 

For columns if you are referencing a column to the left of your starting point, that would be 
negative as well. In our case our column is to the right of our starting point and so is positive.  

Let's look at the syntax of the Offset function and a quick and simple example. 

The syntax is as follows: 

=OFFSET(Reference,Rows,Cols,Height,Width) 

where 

Reference is the place from which you wish to start (your X marks the spot) 

Rows is the number of rows you wish to move either up or down, and 

Cols is the number of columns you wish to move either left or right. 

The following two arguments are optional and are used when the resulting reference is greater 
than one cell. 

Height is the number of rows high you want the result to be, and 

Width is the numbe of columns wide you want the result to be. 

Some of you may be saying to yourselves, why should we go to all that trouble when we can 
just link directly to the specific cell. 

That is a great question...and we’re going to show you an equally great answer. 

Why Excel has included the Offset function and where it comes in handy is where you know the 
position of the cell in relation to another one, but you don't know the exact cell address. 

Let's work through an example to make this crystal clear. 
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We are going to perform a reconciliation of data on two lists which we have extracted from 
different sources and placed in an Excel worksheet next to each other. We have sorted both 
lists in ascending order to make our tasks easier. 

After placing these lists next to each other we have inserted an extra column and used Excel's 
EXACT function to test if the values in each set of data are indeed the same. 

 
 
As you can see, when we get to 52310 Staff Uniforms on the left hand side list we discover 
that it is not present on the other side. This is one item that is causing the difference. 

To enable us to continue checking we insert cells in the right hand list where the missing entry 
should be and move all the other entries down one cell. 
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We've now moved the entries on the right hand side down one cell and although we can see 
that they match, Excel is telling us that they don't. What's going on? 

Take a look at the formula bar and you will see what the problem is. The formula bar is 
displaying the formula for cell D10 and clearly it is no longer looking at row 10 for both lists. 

Because we shifted the cells down on the right hand list, the formula is now looking at row 10 
on the left hand list but looking at row 11 on the right hand list. 

We need to ensure that when we find discrepancies between the lists and we add rows, the 
formula will always look at both sides on the same row. 

Changing the Excel formula to use the Offset function will accomplish what we want. 

We change the formula in cell D2 to =EXACT(OFFSET(D2,0,-2),OFFSET(D2,0,3)) and then copy 
this down to all the relevant cells in column D. 

Now, whenever we insert cells and move the others down the Exact function will always 
compare the cell two columns to it's left with the one 3 columns to its right. 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Conditional 

Formatting 

What is Conditional Formatting? 

Conditional formatting allows you to set rules for cell 
formatting. If the rules (conditions) are met, then the 
formatting is applied. You can have up to 3 rules in a cell. 

For example, you can set conditional formatting so that a 
cell turns blue if it contains a value higher than 75 and turns 
green if it contains a value lower than 50.  

 

Apply Conditional Formatting to a Cell 

 
1. Select the cells to be formatted 
2. Choose Format>Conditional Formatting... 

 

3. Leave the first drop-down box set to Cell Value Is 
4. In the second drop-down box, choose one of the 

operators. In this example, choose 'greater than' 
5. In the text box, type a number or a cell reference. In this 
example, type the value you want to check -- 75. 
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6. Click the Format button 

7. On the Patterns tab, select a colour for the conditional formatting -- blue, in this example.  
You can also choose a Font format or a cell Border. 
8. Click OK. 

 

9. To add another conditional format, click the Add button. 
10. Repeat steps 3 to 8, using the values and colours for the second conditional format. 
11. Click OK, to return to the worksheet. 
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Conditional Formatting - Based on Another Cell 
 
Apply Conditional Formatting to a Row 

You can apply conditional formatting that checks the value in one cell, and applies formatting 

to other cells, based on that value. For example, you could color the entire row in a table, if 
the values in column B are over a set value. 

 

1. Select the cells to be formatted (A2:D4 in this example) 

2. Choose Format | Conditional Formatting... 

3. From the first drop-down list, choose Formula Is 
4. In the text box, enter a formula that refers to the active cell in the selection. 

        In this example, the formula is: =$B2>75 

Use an absolute reference to column B ($B), to ensure that the conditional formatting in all 
columns refers to the value in column B. Otherwise, the formula will be adjusted in each 
column, and won't work properly.  

 

5. Click the Format button. 
6. Select the formatting options, click OK 
7. Click OK  

 

Conditional Formatting - Examples 

Hide Errors  

You can use conditional formatting to check for errors, and change the font color to match the 

cell color. In this example, if column B contains a zero, the #DIV/0! error is displayed in 
column C. 
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Building skills for success 

 

 

1. Select cells C2:C5  
2. Choose Format | Conditional Formatting  
3. From the first dropdown, choose Formula Is  

4. For the formula, enter a formula that refers to the active cell in the selection: 
=ISERROR(C2) 
or, to hide only #N/A errors: =ISNA(C2) 

 
5. Click the Format button.  
6. Select a font color to match the cell color.  
7. Click OK, click OK  

 

Hide Duplicate Values 

In a table, each row should have all data entered, to enable sorting and filtering. However, you 
can hide the duplicate values, to make the list easier to read. In this example, when the table 

is sorted by Region, the second (and subsequent) occurrences of each region name will have 
white font color. 

 

1. Select range A2:A5  
2. Choose Format | Conditional Formatting  
3. From the first dropdown, choose Formula Is  

4. For the formula, enter =A2=A1  
5. Click the Format button.  
6. Select a font color to match the cell color.  
7. Click OK, click OK 
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Highlight Duplicates in Column 

Use conditional formatting to highlight duplicate entries in a column: 

1. Select range A2:A11  
2. Choose Format | Conditional Formatting  
3. From the first dropdown, choose Formula Is  

4. For the formula, enter =COUNTIF($A$2:$A$11,A2)>1  
5. Click the Format button.  
6. Select a font color for highlighting.  
7. Click OK, click OK  

 

 

Highlight Items in a List 

Use conditional formatting to highlight items that are in a list on the worksheet.: 

1. Create a list of items you want to highlight. 
2. Select range A2:A7  
3. Choose Format | Conditional Formatting  
4. From the first dropdown, choose Formula Is  
5. For the formula, enter =COUNTIF($C$2:$C$4,A2)  

or, if the list is named, use the name in the formula: 

=COUNTIF(CodeList,A2)  
 

6. Click the Format button.  

7. Select a font color for highlighting.  
8. Click OK, click OK 
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Highlight Lottery Numbers 

You can highlight the ticket numbers that have been drawn in a lottery. In this example the 
ticket numbers are in cells B2:G4, and the drawn numbers are entered in cells B6:G6 

1. Select cells B2:G4  
2. Choose Format | Conditional Formatting  

3. From the first dropdown, choose Formula Is  
4. For the formula, use the CountIf function: 
     =COUNTIF($B$6:$G$6,B2)  

 
5. Click the Format button.  
6. Select formatting options (green pattern, in this example), click OK  
7. Click OK  

 

 
Highlight Upcoming Expiry Dates 

You can highlight payments that are due in the next thirty days. In this example, Due dates 
are entered in cells A2:A4.  

1. Select cells A2:A4  
2. Choose Format | Conditional Formatting  

3. From the first dropdown, choose Formula Is  
4. For the formula, use the Today function count the days: 
     =AND(A2-TODAY()>=0,A2-TODAY()<=30) 

  
5. Click the Format button.  
6. Select formatting options (Bold, Blue font, in this example), click OK  
7. Click OK 

 

 

 

 

Hide Cell Contents When Printing 
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You can use conditional formatting to hide cells when printing. In this example, the contents of 
cells B2:F4 are changed to white font, if cell H1 contains an x. 

 

To print with the cell contents hidden, type an x in cell H1. To display the cell contents, delete 
the x in cell H1. 

1. Select cells B2:F4  
2. Choose Format | Conditional Formatting  
3. From the first dropdown, choose Formula Is  
4. For the formula, enter    =$H$1="x"  

5. Click the Format button.  
6. Select formatting options (white font, in this example)  
7. Click OK, click OK 

 

 

 

 

 

 

 

 

 

 


